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In this lesson you will learn how to: 

• Change the schedule’s date range 

• Change the schedule’s date headings 

• Change the schedule’s dimensions 

• Change the legend and add a new legend entry 

• Work with pages and page numbers 

• Work with the schedule’s current date  

• Change the schedule’s horizontal gridlines and shading 

• Change the schedule’s vertical gridlines 

Change the schedule’s  date headings 

At the top of the schedule click on the month date heading. It will highlight in black and white and the toolbar will change to 
the Selection tab with Current Object: Date Heading.  This contains all date heading options.  Follow the numbered steps 
below to add a third date heading and set its properties. 

1. In the Date Headings section, in the third slot, choose Quarterly (CY): 1,2,3,4,1,2,.  

2. Also in the third slot, select the (B) Bold icon. 

3. Click the color swatch to change the font color to Navy or your color choice. Change the font size to 10.   

4. In the Background section, click the color swatch and change to Silver or your color choice. 

5. In the Effects section, choose To Bottom.  Effects create a 
gradient from the Background color to the Target Color. 

6. In the Prefix section, type in Quarter and press the 
(apply button). The word Quarter is added in front of the 
quarterly number.  (Prefix and suffix options are available 
with most date headings.) 

Open the schedule for this Lesson 

1. On the toolbar, choose File.  

2. In the Files and Templates: Open and Save Options section select Open 
Samples or Lesson.  The Open a Sample Chart dialog displays. 

3. Under Select a Folder below to Open and select Lessons.  The Lesson 
schedules will display in the window to the right. 

4. Pick Lesson 01 Starter Schedule.mlj.  

5. Save the schedule to an accessible folder on your computer. On the File 
tab, in the Files and Templates: Open and Save Options section, 
choose Save As….  In the menu that displays choose Chart.  Name, then 
save the schedule. 

Lesson 1 - Format a Schedule 

Lesson 1 Starter Schedule 

Change the schedule’s date range. 

1. Choose the Dates tab. 

2. In the Start and End Dates section, use 
the Calendar icon to change the Dis-
played End Date to 5/31/2020 . 

Changed Date Range 

Changed Date Heading 
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Change the legend properties and add a new legend entry 

Change legend properties 

1. Choose the Layout tab.    

2. In the Legend Size section, click on the Full Legend Settings. The toolbar changes 
to the Selection tab Current Object: Legend which contains all legend options.  
Follow the numbers to change the legend properties. 

In the Legend Size and Frame Settings section: 

1. Check on Floating Legend. 

2. For Legend Symbol Size Override, choose 1.25. 

3. Change Entries per Row to 1. 

4. Select option 10 for Alternate Border for Legend. 

5. Choose the color swatch and change to Navy or your color choice. 

6. In the Font Settings section:  
6. Change the font style to Comic Sans MS or your font style choice. 

7. Change the text size to 14.     

8. Click the corners of the legend and drag to adjust its size. 

9. Click on the legend and drag the legend to move it to another location on the schedule.   

Add a new Legend Entry 

1. Click the Insert tab. 

2. In the Picture, Legend section choose New Legend Entry.  The toolbar changes to the Selection tab Current Object Leg-
end Entry which contains all options for that legend entry.  Follow the numbers to add a legend entry. 

3. For Line1, enter Key Milestone. 

4. Press Apply Text Changes. 

5. Check on Show Symbol One. Then, select the drop down and choose the first dia-
mond symbol in the list. 

6. Click the corners of the legend and drag to adjust its size. 

Change the schedule's dimensions 

1. Choose the Layout tab. 

2.  In the Page Size section, change the Horiz. value to 14. 

3. Change the Rows per Page to 6. 

4. Press (Apply Setting Changes.)  The schedule is now 
wider and has fewer lines. 

Changed Legend 

New Legend Entry 
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Insert a page 

1. Choose the Insert 
tab. 

2. In the Page sec-
tion choose to 
Insert a New Page 
after the Last 
Page.  The sched-
ule now has two 
pages.  

Change the page number properties 

1. In the toolbox, select the () Arrow tool to click on the page number.  The toolbar changes to the Selection tab Current 
Object: Page Number which contains all option for the page number.  Follow the numbers to change the page number 
properties. 

In the Page Number Override Settings section  
2. For Starting Displayed Page Number type in 1.  Press  to apply the change. 

3. For Page Number Prefix type in IMS– .  Press  to apply the change. 

4. For Page word, Page by default is already typed in, if not type in Page.  Press  to apply 
the change. 

5. Check on Exclude the “of_” phrase. 

Remove page numbers 

The page number displays in the top left corner above the schedule. 

1. Choose the View tab. 

2. In the Optional Items section, uncheck Page Number to remove page numbers. 

 
Add page numbers  

1. Choose the View tab. 

2. In the Optional Items section, check on Page Number to make page numbers visible again. 

Quickly hide page numbers and change page number properties by right-clicking the page number 
on the schedule and making a selection from the menu. 

Delete the page which was just added 

1. Look at the top left corner of the sched-
ule.  It will say Page 1 of 2 or Page 2 of 2. 

2. If it says Page 1 of 2, use the keyboard’s 
Page Down( PgDn) key to move to page 
2.  

3. Once on page 2, choose the Edit tab. 

4. In the Delete section choose the X for 

Current page.  The schedule now has just 
one page again. 

Edit Tab 

Changed Page Number 

Work with pages and page numbers 

In a future lesson you will learn about freeform text.  With freeform text, it’s possible to put the page number any-
where on the schedule using substitutable text, like &curpage.  In the toolbox, select the (T) Text tool. On any 
empty part of the schedule’s page, type: Page &curpage.  
Learn more about Substitutable Text under the Help tab Help Topics. 

Original Page Number 
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Work with the schedule’s current date  

By default Milestones uses the current date from your computer.  The Dates tab is used to change date options. 

Override the current date  

1. Click the Dates tab.  In the Current Date section click the calendar icon for Set Override.  Set the date to March 20, 2020. 

2. The override can be removed by clicking Press to Clear. 

 
Show the current date  

3. In the Current Date section, check on Display Date to show the current date in the top right of the schedule.       

 
Show the current date line 

4. In the Current Date section, check on Display Date Line to add the current date line.    

 
Change current date properties 

5. In the Current Date section, select More Current Date Options     .  The toolbar will changes to the Selection tab Current 
Object: Current Date which contains all current date options. Follow the numbers to change the current date properties. 

In the Current Date section: 
1. Check on Use custom date format.   

2. Enter the following: 
 dddd MMMM dd, yyy 

3. Press to apply the changes.   

In the Font section: 

4. Select the (B) Bold icon 

5. Set Color to Green or your color choice. 

6. Set the font size to 16. 

In the Date Line section: 
7. For Line Type, choose the drop down, then select the first long dash option in the list.  

8. For Thickness, choose the drop down, then select 3 in the list.  

9. For Color choose Blue or your color choice. 

More about Current date: 

• To change the Current Date and Date Line properties click  the current date text on the schedule.  The toolbar will present the cur-
rent date and current date line properties. 

• On the schedule, right-click the current date to hide the date or date line and change their properties. 

Current Date and Current Date Line Display 

Select the  icon to view 
codes to change the date format. 
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Change the schedule’s horizontal gridlines and shading 

Change the gridlines and shading 

1. Select the Format tab. 

2. In the Gridlines section click Horizontal Gridlines and Shading.   

3. At the bottom of the dialog box, check on  Apply New Selec-
tions to all Three Sections.  When checked,  selections made 
will apply to all three sections Left Columns, Graph/Schedule 
Area and Right Columns. 

4. To turn off gridlines choose the Gridlines tab. 

5. In the Left Columns section, uncheck  Show Gridlines.  Graph/
Schedule Area and Right Columns will also uncheck. 

6. To turn off shading choose the Shading tab.   

7. In the Left Columns section, uncheck Shade the Task Row. 
Graph/Schedule Area and Right Columns will also uncheck. 

8. Click OK.  The shading and grid lines have been removed. 

Change individual gridlines and shading 

1. Select the () Arrow tool in the toolbox.  Hold the Ctrl key.  

Under the heading Task, click once on the first, second and 

fourth task rows to select them.  The tool bar changes to the 

Selection tab with Current Object: Task Row. 

2. In the Task Row Settings section, choose the down arrow next 
to More Task Row Options. 

3. In the drop down menu choose Gridlines/Shade.  The Horizon-
tal Grid and Shading Properties dialog box displays. 

4. Choose the Shading tab. 

5. Under Left Columns section check on Shade the Task Rows. Graph/Schedule Area and Right Columns will also check on. 

6. Under Left Columns section change Shade Color to light yellow or your color choice.  Graph/Schedule Area and Right 
Columns will also show selected color. 

7. Under Left Columns section change Special Effects to None. Graph/Schedule Area and Right Columns will also change. 

8. Choose OK. 

Change the schedule’s vertical gridlines 

1. Choose the Format tab. 

2. In the Gridlines section choose the Vertical Gridlines…. 
The Vertical Grid Options dia-
log box will display. 

3. On the Yearly to Weekly tab 
check on Monthly. 

4. For Monthly Line Type select 
number 21. 

5. For Monthly Line Color select 
silver or your color choice. 

6. Click OK. 

If a schedule is outlined, formatting can be set for each outline level.  Choose Format.  In the Gridlines section, click on Gridlines, Shad-
ing, Font Sizes by Outline Level….  Formatting options include gridlines, shading, text attributes, and summary bar symbol settings.  

Light blue Line Guides are visible.  To turn off go to the View 
tab in the Optional Items section uncheck Line Guides. 

Schedule with No Shading or Gridlines 

Schedule with Selected Task Rows Shaded 

Schedule with Vertical Gridlines 
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In this lesson you will learn how to: 

• Enter project steps 

• Add a symbol (milestone) and/or symbol, horizontal 
bar, symbol combination using the toolbox 

• Add a column 

• Move a column 

• Add a schedule title 

 

Open and save the schedule for this lesson 

1. On the toolbar, choose File.  

2. In the Files and Templates: Open and Save Options section 
select Open Samples or Lessons.  The Open a Sample Chart 
dialog displays. 

3. Under Select a Folder below to Open, select Lessons.  The 
Lesson schedules will display in the window to the right. 

4. Pick Lesson 02 Starter Schedule.mlj.  

5. Save the schedule to an accessible folder on your computer. 
Choose the File tab.  In the Files and Templates: Open and 
Save Options section, choose Save As….  In the menu that 
displays choose Chart.  Name, then save the schedule. 

Enter the project steps 

1. Click  the (T) Text tool in the toolbox. 

2. In the first space below the column heading, “Project Steps”, click once.  

3. Type in: Get materials.  Press the down arrow on the keyboard.  This moves 
the cursor to the next task row.  (You can also click with your mouse within 
the cell of the next task row.) 

4. Type in: Tear off old roof.  Press the down arrow on the keyboard to move 
down to the next row. 

5. Type in: Put down tar paper.  Press the down arrow on the keyboard to 
move down to the next row. 

6. Type in: Nail on shingles.  

 

 

Note: Pressing the down arrow while in the last row 
on a page may take you to a new (blank) page.  If 
this happens, use the Page Up keyboard key to 
move back to Page 1 or delete the unwanted page 
Edit | Delete | Current Page. 

Lesson 2 - Add Tasks, Dates, and a 
Title to the Schedule 

Lesson 2 Starter Schedule 

Entered Tasks 
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Add a symbol (milestone) and/or symbol, horizontal bar, symbol combination using the toolbox 

Add a symbol, horizontal bar, symbol to the "Get materials" step 

1. Click once on the (+)Small Plus to the left of the 
first symbol, bar, symbol combination in the 
toolbox.  The entire row will highlight . 

2. Using the mouse, move the cursor into the schedule area to the right 
of Get materials, as shown in the Cursor with date display image. The 
date Tuesday  9/1/20 will display next to the cursor.  Click (and hold) 
the left mouse button.  

3. Drag the mouse 2days to the right until the cursor or the status bar 
(bottom left of the Milestones window) shows Thursday 9/3/20. 

4. Release the mouse button.  The task has been added and the Start 
and End column cells are populated. 

Added Task Bar 

Added Task Bar 

Added Symbol (Milestone) 

Added Using the (T) Tool or Calendar 
Icon 

To turn on (or off) calendar icons:  View | Optional Items | Show calendar icons in date columns. 
Symbols and bars added using the Start and Finish columns can be chosen by selecting the Column Heading.  Next select  Switch to Col-
umn. In the Date SmartColumn Display Settings section choose the drop downs for Normal Start Symbol, Bar, and Normal End Symbol. 
The symbols and bars that can be selected are from the toolbox. 

Add two symbols with a bar to the "Nail on shingles" step 

A different option for adding two symbols with a bar:  

1. Select the (T) Text tool in the toolbox. 

2. Move the cursor to the Start column cell for Nail 
on shingles.  Type in  9/8/20 or use the calendar 
icon to select 9/8/20.  A green diamond Mile-
stones will be added. 

3. Move the cursor to the End column cell for Nail on shingles.  Type 
in  9/10/20 or use the calendar icon to select 9/10/20.  A striped 
horizontal bar with a red diamond will be added 

Add a single milestone to the "Put down tar paper" step 

1. In the toolbox select  the (+) Plus tool and the green 
diamond. 

2. Using the mouse, move the cursor into the schedule 
area to the right of Put down tar paper. 

3. Click and drag the mouse to the right until the cursor 
shows Monday 9/7/20.  Release the mouse button. A single mile-
stone is added and the Start and End column cells are populated. 

Add two symbols with a bar to the "Tear off old roof" step 

1. Using the mouse, move the cursor into the schedule area directly to 
the right of Tear off old roof. 

2. When the date displayed next to the cursor or in the status bar dis-
plays Thursday  9/3/20: 

A. Click (and hold) with the left mouse button. 

B. Drag the mouse to the right until the cursor or the status bar 
shows Monday 9/7/20. 

C. Release the mouse button. The task has been added and the Start 
and End column cells are populated. 

Cursor with Date Display 

Status bar 

For date to show, tooltips must be on Tools | Program Options | Help. 
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Add a column 

A duration SmartColumn automatically calculates and displays the 
duration of each task. 

1. Choose the Insert tab. 

2. In the Rows, Columns section choose New Column. 

3. From the menu, choose Duration.  The Insert Duration Columns 
dialog box displays.   

4. Check on Duration. 

5. Click OK.  The duration column will now be in your schedule. 

Inserted Duration Column 

Move Column Cursor  

Insertion Marker 

The examples below shows moving a column from the left side of the schedule to the right side. 

Duration can be affected by the options Allow Hourly Detail, and Allow 
Minute Detail.  To change these options choose the Dates | More Date 
Settings | Hourly, Minute, and Shift Settings. 

Move a column 

1. Click the () Arrow tool in the toolbox. 

2. Move the cursor to the top border of the column to be moved (the line just 
above Dur. in our example).  The cursor should change to the Move Column cur-
sor. 

3. Click and hold the left mouse button and drag the column to the right side of the 
schedule until you see the Insertion Marker, indicating where the column will be 
inserted. 

4. Release the mouse to drop the column at the insertion point. 

Move Column  
Insert Column 

Moved Duration Column 
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Add a schedule title 

1. Click the () Arrow tool in the toolbox. 

2. Click above the schedule. The toolbar changes to the Selection tab Current Object: Chart Title which contains all Chart 
Title options.  Follow the numbers to add and change the Chart Title properties. 

In the Title Text Settings section: 

3. In Line 1: type in Roofing Project for Smith Family. Select the Press here to apply text changes made above   

4. Select the (B) Bold icon. 

5. Select the color button.  Choose More Colors, then  select Custom Colors’ dark blue or your color choice. 

6. Check on Insert extra space under title. 

In the Background Color section: 

7. Choose the top color button.  Choose More Colors, then  select Custom Colors’ lighter blue or your color choice. 

8. Special Effects choose Fade to Bottom. 

In the Border Shadow section: 

9. Border Type choose Width of Title. 

10.Line Type choose the second dash and dotted option or your Line Type choice. 

Lesson 2 Completed Schedule 
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Open the schedule for this lesson 

1. On the toolbar, choose File.  

2. In the Files and Templates: Open and Save Options section select Open 
Samples or Lessons. The Open a Sample Chart dialog displays. 

3. Under Select a Folder below to Open, select Lessons.  The Lesson 
schedules will display in the window to the right. 

4. Pick Lesson 03 Starter Schedule.mlj.  

5. Save the schedule to an accessible folder on your computer. Choose the 
File tab.  In the Files and Templates: Open and Save Options section, 
choose Save As….  In the menu that displays choose Chart.  Name, then 
save the schedule. 

In this lesson you will learn how to: 

• Add a block of freeform text 

• Customize freeform text 

• Add dates to symbols and adjust the date’s position 

• Add text to a symbol and adjust the text’s position 

• Add text in the middle of a bar using symbol text 

• Add angled text 

• Vertically move symbol text 

• Add a symbol note with picture and move it. Lesson 3 – Work with Text 

Add a block of freeform text 

1. Click the (T) Text tool in the toolbox. 

2. Click in the schedule area, to the right of the Nail on shingles step. The flashing cursor displays. 

3. Type 3-Man crew to arrive. 

4. Press Enter to split the text onto a new line. 

5. Type by 8am daily. 

6. Next to by 8am daily. Type in the following code color 
code <rgb:21,129,165> then click away from the text. This 
code will change this line of text to the color teal.  3-Man 
crew to arrive text will not be affected.  

 

Lesson 3 Starter Schedule 

Added and Color Coded Freeform Text 
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Freeform text will not move with a task row -- it is placed relative to the page. 

Freeform text placement can be adjusted by using the arrow tool in the toolbox. 

Customize the freeform text block 

1. Click the () Arrow tool in the toolbox. 

2. Click the freeform text 3-Man crew to arrive by 8am daily..  The toolbar changes to the Selection tab Current Object: Freeform 
Text which contains all the selected freeform text options.  Follow the numbers to change the selected freeform text properties. 

In the Background Color section: 

3. For Fill Color choose gold or your color choice. 

4. For Effects choose Fade to Bottom. 

5. Uncheck Transparent (Disables Background Color). When this option is checked on the background of the freeform text will not 
color (is transparent.) 

In the Font section: 

6. For Text Style choose the (B) Bold, (I) Italic and (U) Underline icons. 

7. For Text Color choose medium brown or your color choice. The first line of freeform text 3-Man crew to arrive color will change. 
The second line of freeform text  (by 8am daily.) that has been color coded will not be affected. 

8. For Horizontal Alignment choose the middle icon. 

9. Change the font size to 20. 

In the Border section: 

10. For Color choose dark brown or your color choice. 

11. For Line Type choose 9. 

12. Check on Draw Border. This will 
cause the dark brown border to 
draw. 

Customized Freeform Text Block 
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Display dates with symbols 

Globally 
1. In the toolbox, double-click the symbol, that is used for 

the start symbols on your schedule.  The Symbol Options dia-
log box displays. 

2. Click the Text/Date Properties tab. 

3. Under Date Placement, choose Above and Center. 

4. Click OK.  Above each symbol its date is displayed. 
To change the symbol date format, choose Dates | Date 
Related Settings | Set Symbol Date Format.  Choose from a 
list of predefined formats or create a custom format. 

Individually 
1. Click the () Arrow tool in the toolbox 

2. On the schedule, in the task row for Tear off old roof click     (the end symbol.) 

3. The toolbar changes to the Selection tab Current Object: Symbol which contains all that symbol’s options.  Follow the numbers 
to change the selected symbol’s date properties. 

4. On the Text tab in the Date Placement section for Vertical select 
Above.  The date will now display on that symbol. (In the same 
format as the start symbol’s date.) 

5. Change just this symbol’s date format. In the Text section for Cus-
tom Date, type in the following code: ddd. M/d/yy.   

6. Press the Apply Text Changes button.  The date 
Tue. 5/25/21 will display above the end symbol. 

Adjust symbol date position with the keyboard 

1. Click the () Arrow tool in the toolbox. 

2. On the schedule, click once on the symbol with the symbol date to be moved.  

3. Hold down ALT + CTRL. 

4. Click the arrow keys on the keyboard to move the symbol date around the symbol.  The symbol date will move as you click the 
arrow keys. 

Date Displayed on Symbols 

Customized Date Displayed on a Symbol Select the  question mark icon to view all availa-
ble codes for the custom date format. 
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Annotate a symbol with symbol text 

1. Click the () Arrow tool in the toolbox 

2. Click (the end symbol for the Get materials step).  The toolbar changes to the Selection tab Current Object: Symbol which 
contains all that symbol’s options.  Follow the numbers to add and customize this symbol’s text. 

3. In the Text section for Line 1 type in Materials:. 

4. Press the Apply Text Changes button. 

5. In the Text section click Text Overrides for Line 1.  The Symbol Text Line 1 
Overrides dialog box will come up.   

a. Under Text Color Override click the Press to Change Color rectangle 
to open the color palette. Choose light brown or your color choice 

b. Under Text Attributes Overrides check on Italic Override. 

c. Click OK. 

6. In the Text section for Line 2 type in Tar Pa-
per, Shingles, Nails. 

7. Press the Apply Text Changes button. 

8. In the Text Placement section, for Horizontal 
choose Right. 

9. In the Text section, for Date Suffix, type in 
Est.. 

10.Press the Apply Text Changes button. 
You will not see any change until the next 
step. 

11.In the Date Placement section, 
for Vertical choose Below. 

 

Adjust symbol text position with the keyboard 

1. Click the () Arrow tool in the toolbox.. 

2. On the schedule, click once on the symbol with the text to be moved. 

3. Hold down the ALT key. 

4. Click the arrow keys on the keyboard to move the text around the symbol.  The text will move as you click the arrow keys. 

To change the default symbol text style, color, size and attributes choose Format | Default Text | Symbol Text.  By selecting a symbol or group of 
symbols they may have their own symbol text size, color and attributes.  Symbol date is considered symbol text thus it will have the same look.  
Symbol text color override can be set in the toolbox, Symbol Options dialog choose the Color/Pattern/Size/Shadow tab.  

Added and Customized Symbol Text 
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Add text in the middle of a horizontal bar using symbol text 

1. Click the () Arrow tool in the toolbox. 

2. Click the start symbol for Tear off old roof.  The toolbar changes to the Selection tab Current Object: Symbol which contains 
all that symbol’s options.  Follow the numbers to add symbol text to the horizontal bar. 

3. In the Text section for Line 1 type in Smith Const.. 

4. In the Font section, for Color choose Gold or your color choice. 
This will also change the symbol’s date color. 

5. Press the Apply Text Changes button. 

6. In the Text Placement section, for Vertical choose Middle. 

7. In the Text Placement section,  for Background 
choose Transparent. 

8. In the Text Placement section, check on Center Text 
on Bar. 

Draw symbol text at an angle  

1. Click the () Arrow tool in the toolbox. 

2. Click the star symbol for Put down tar. The toolbar changes to the Selection tab Current Object: Symbol which contains all 
that symbol’s options.  Follow the numbers to add angled symbol text. 

3. In the Text section for Line 1, type in RAIN SCHEDULE. 

4. Press the Apply Text Changes button. 

5. In the Font section for Color, choose teal or your color 
choice. 

6.  In the Font section, select the (B) Bold icon. 

7. In the Font section, for Size select  18. 

8. In the Text Placement section, for Vertical choose Above. 

9. Check on  Draw Text at Angle.   

Angled text will only show the first line of text as a single 
line of text regardless of how many lines of text are en-
tered.  

The default angle is set to 45 degrees.  To change the 
angle select Tools | Program Options | Edit | Angle for 
Angled Symbol Text . 

Always use the left-most symbol to enter text for a bar. 

Use Symbol Text  when text needs to "stick" to a task 
or symbol when the schedule updates. 

Text in the Middle of a  Horizontal Bar 

Angled Text 
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Vertically move symbol text 

1. Click the () Arrow tool in the toolbox. 

2. On the schedule in the task row for Nail on shingles click the end symbol.       

3. The toolbar changes to the Selection tab Current Ob-
ject: Symbol which contains all that symbol’s options.  
Follow the numbers to change the selected symbol’s 
date properties. 

4. In the Text section, for Line 1 type in Complete.  Line 
2 type in upon inspection. 

5. Press the Apply Text Changes button. 

6. Choose the Tools tab.  

7. In the Customize section choose Symbol Text Move.   

8. Under Symbol From Toolbox choose the fourth symbol in the list, the plus symbol (best to use 
a symbol that is not being used on the schedule). In the toolbox the symbol will change to 
shape #28, an invisible symbol. 

9. Under Vertical Link From Toolbox, choose the second vertical link in the list, the dotted line 
with arrow. 

10.Choose OK. 

11.On the schedule, click and hold on the symbol with the Complete upon inspection text. 

12.Hold down Ctrl + T. 

13.Drag to move the text to the task row above. The text is no longer attached to the end 
symbol on Nail on shingles.  It is now attached to a blank symbol on the task row 
above. 

14.Reposition the text Completion upon inspection by repositioning the symbol it is attached to now. Click on the text in the sched-
ule and the symbol will be selected.  The toolbar changes to the Selection tab Current Object: Symbol which contains all of that 
symbol’s options.  Follow the numbers to change the selected symbol’s date properties. 

15.Use the calendar icon to change the symbol’s 
date to 5/27/2021. 

16.Change the Time to 24:00. Now the text will be 
inside the schedule’s border. 

17.Choose the Size/Color tab. 

18.In the Other Overrides section, under Vertical 
Symbols Position choose 2 levels down.  Now the 
text will be just above the symbol. 

Vertically Moved Symbol Text 
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Symbol Note with Picture 

Add a picture to the schedule and give it a tag for use in a symbol note 
1. On the Insert tab, in the Picture, Legend section, choose Picture from File. Navigate to the Program Files\KIDASA\Milestones 

Professional 2021\Samples\Lessons and choose dumpster.jpeg 

2. When the picture cursor appears, click on the schedule to add the picture.  Drag a corner of the picture to make it larger. 

3. With the () Arrow tool in the toolbox click the picture which is now on the schedule.  The toolbar changes to the Selection tab 
Current Object: Picture which contains all the selected picture's options.  Follow the numbers to change the picture’s properties. 

4.  In the Automation Tag, type in dumpster to name the picture.  

5. Press the Apply button. 

6. Choose Convert to Embedded Picture. 

7. In the Page section, for Current Page enter 2. 

8. Press the Update Page button. The picture will be moved to page 2 and now is ready to be used in a note. 

Add a note with a picture to a symbol 

1. Click the () Arrow tool in the toolbox.  Click the end symbol for Tear off old roof.  

2. The toolbar changes to the Selection tab Current Object: Symbol. At the bottom of the toolbar choose the Notes tab. The 
toolbar now displays symbol note properties.  Follow the numbers to add a note with a picture. 

3. In the Symbol Note Display section, check on Display Note on Schedule.  

4. In the note text box type in  

a. Dumpster removal by Waste Management. 

b. Press the keyboard Enter and type in the following markup code to 
have the picture show in the notes on the schedule.  <image 
tag=“dumpster”> (The dumpster in the tag refers to the picture which 
was “tagged” dumpster in an earlier step.) 

c. Press Enter.  Then type in the following: Thursday 
<i><b><rgb:255,0,0>   (Anything inside <> is a “markup code” used to 
change the characteristics of that line of text  <i> for Italic, <b> for 
bold, and <rgb:255,0,0> for red.) 

5. Press the Apply Text Changes button.  Use hard line breaks to control the line breaks in the displayed note, as text is not word 
wrapped. A line is limited to no more than 150 characters 

Before an image can be shown in a symbol note, it has to be added to the file.   

The size of the image on the schedule determines the size that will be shown in the symbol note.  Drag the corner of the picture to resize 
the picture  to the size you would like in the note.  

Moving a picture to a page does not add a page to the file.  It stores the picture on that page. The Manage Pictures option on the Tools menu 
makes it easy to find, move from page to page or delete a picture. 

If sharing the schedule with other users of Milestones Professional the picture needs to be embedded in the schedule. 

Images need to be named to display  in a note.   

Symbol Note with Picture 

To set symbol note default properties for text and look 
choose Format | Default Text |Symbol Notes. 
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Format and move the symbol note just added 

1. Click the () Arrow tool in the toolbox.  Click the end symbol for Tear off old roof.  

2. The toolbar changes to the Selection tab Current Object: Symbol. At the bottom of the toolbar choose the Notes tab. The 
toolbar now displays symbol note properties.  Follow the numbers to change the selected symbol note’s properties. 

3. Choose B for bold. 

4. Select the color rectangle to open the color palette. Choose Teal or your color choice. 

5. Choose 11 for font size. 

6.  For Connector Type choose the third option from top. 
 
 

7. For Color choose Teal or your color choice. 

8. For Background Color choose Yellow or your 
color choice. 

9. For Target Color choose Aqua or your color 
choice. 

10. For Frame Color choose Teal or your color 
choice. 

11. For Special Effects choose Fade to Bottom. 

12. For Frame Type choose a bold line. 

13. Use the direction controls to move the sym-
bol note.  (Or using the mouse, click on the 
note and drag it to the space next to Put 
down tar paper.) 

Only Dumpster removal by Waste Management text will be affected by this selection. 

The connector draws a link between the notes box and the symbol. 

Default symbol note formatting can be set by selecting the Format | Default Text | Symbol Notes.  
 
Use Note Text (or symbol text) on dense schedules when text needs to "stick" to a task or symbol when the schedule updates. 
 
To have text stick to a task without displaying a symbol, consider using a comment symbol.  A comment symbol can be a blank symbol or a very 
small symbol on a task row.  The comment symbol is ignored when computing start date, end date and duration so it can be placed anywhere on 
the schedule.  To create a comment symbol, just double-click any unused symbol in the toolbox and choose Comment Symbol under the Symbol 
Shape tab. 

Symbol Note with Picture 

Only Dumpster removal by Waste Management text will be affected by this selection. 
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Open the schedule for this lesson 

1. On the toolbar, choose File.  

2. In the Files and Templates: Open and Save Options section select 
Open Samples or Lessons.  The Open a Sample Chart dialog displays. 

3. Under Select a Folder below to Open, select Lessons.  The Lesson 
schedules will display in the window to the right. 

4. Pick Lesson 04 Starter Schedule.mlj.  

5. Save the schedule to an accessible folder on your computer. Choose 
the File tab.  In the Files and Templates: Open and Save Options 
section, choose Save As….  In the menu that displays choose Chart.  
Name, then save the schedule. 

Change the ToolBox to Sidebar or Floating  
The sidebar displays the toolbox and shortcut buttons anchored to the left or right side of the Milestones window. The 
floating ToolBox can be moved around on the Milestones Window. It does not contain shortcuts. 

To access the sidebar options or select the floating ToolBox, right-click anywhere on the ToolBox, choose Sidebar Options. 

 

Milestones Professional needs to be restarted  when the Sidebar’s location and Floating toolbox settings are changed. 
Changes made in the Sidebar Options dialog box apply to all schedules. 

Docked ToolBox in Sidebar 

Floating ToolBox  (can be moved anywhere in window) 

In this lesson you will learn how to: 

• Change the Toolbox to Sidebar or Floating 

• Change the combo ToolBox size and highlighting. 

• Change the appearance of  symbols  

• Change the appearance of a horizontal bar  

• Change the appearance of a vertical link  

• Copy a ToolBox to another schedule 

• Copy a ToolBox row  

 Lesson 4 – Customize the ToolBox 

There are two ToolBox views, the Standard (recommended )and Legacy ToolBox. To switch to the Legacy ToolBox choose Tools | Program 
Options| Edit | Use Legacy ToolBox. To switch back to the Standard ToolBox right click the ToolBox and choose Standard ToolBox. 

Visible shortcuts in the sidebar depend on the size of the ToolBox (number of rows set), the size of the computer’s screen and the maxi-
mization of the Milestones window. 

Lesson 4 Starter Schedule 
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Change the Standard ToolBox size and highlighting  

Here is a copy of the ToolBox for this schedule.  All of the major components of the ToolBox are indicated: 

To see how to change the look of the ToolBox, right-click the ToolBox and choose ToolBox Properties.  The Customize 
ToolBox Size, Type, Highlight dialog box displays. 

Under ToolBox View Settings: 

• Open File with Arrow Tool Active is a default setting that helps to prevent unintended changes to a schedule when it is 
first opened. 

• Under Rows, select between 1 and 32 rows of Symbol, Bar Symbol combinations to display in the ToolBox. You will 
learn how to do this in subsequent pages of this tutorial. 

• Horizontal bars in Milestones can show status by coloring the bar in two different colors. 
By selecting In Bars, show both before and after status colors  the bars in the ToolBox will 
show two colors. IMPORTANT the feature Bars: Fill to Status  Date needs to be checked 
on.  (Go to Dates |Dates Related Setting |Bars Fill to Status Date.) 

• Extra Highlighting for Selection (black border) helps give a better view of which tool, symbol, bar 
and vertical link is active. 

• Milestones also highlights the background of the active tool, symbol, bar and vertical link with the 
color aqua, by default. You can pick the background color by first selecting show Background Col-
or for Current Selection then the Color. 

• To decrease the size of the ToolBox the Drawing Tools row can be hidden by unchecking  
Show Line, Box, and Circle Tools. 

• Next to Vertical Link Rows select between 0 and 2 rows to display. 

• Double the ToolBox display size is helpful  for high resolution monitors. When this option is 
selected Milestones needs to be closed, then opened for the ToolBox change to take affect. 

• Right click the ToolBox, select Show Symbol and Bar Numbers in ToolBox. This option is 
helpful for importing and automation. 

• Right click the ToolBox to Hide ToolBox.  To show the ToolBox check on ToolBox by going to 
View |Optional Items. 
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Change the appearance of symbols in the ToolBox  

Any symbol in the ToolBox can be customized.  If a ToolBox symbol is changed, then if that symbol exists on the schedule, all 
symbols of that type on the schedule will change accordingly.  

Change the red triangle’s shape 
Notice a red triangle symbol is in the ToolBox, each task row contains a red triangle symbol and the red triangle symbol is in 
the schedule’s legend.  Changing attributes of the red triangle in the ToolBox will affect all instances of that symbol on the 
schedule and in the legend. 

1. In the ToolBox, double-click on the red triangle symbol.  The 
Symbol Options dialog box displays. 

2. Select the Symbol Shape tab. 

3. Standard Shapes, scroll and select 18, small vertical dash. 

4. Stay in the dialog box. 

 

 

 

Change the symbol’s color and text for this symbol’s color 

1. Click the Color/Pattern/Size/Shadow tab. 

2. Change Fill Color to Black. 

3. Change Text Color Override to White. 

4. Stay in the dialog box. 

 

 

 

 

 

 

 

 

Change the Text Background and Placement and Date Placement 

1. Click the Text/Date Properties tab. 

2. Under Date Placement, choose Hide.  

3. Under Text Placement, choose Middle and Bar.  

4. Under Text Background, choose Transparent. 

5. Choose OK.  

6. Because symbols are currently on the schedule the Select 
Items to Change dialog will display. Leave all items checked as 
there are no current individual overrides for any of the red 
triangles on the schedule and you want all the changes to be 
applied to each red triangle on the schedule. (Uncheck the 
items to keep individual overrides.) Choose OK. See the results 
on the next page. 

In order to have horizontal bars or vertical links on a schedule 
there must always be symbols to place the bar and vertical link 
between. To have the look of just a bar you can use the above 
chosen symbol or use Standard Shapes: 28 (invisible symbol) at 
either end of the horizontal bar. 

Already selected is Normal Symbol. This 
is the options that should be used most 
often. Comment Symbols are ignored in 
calculations and Refresh.  Status Sym-
bols are used to show status and per-
cent complete. Baseline Symbol have 
there own set of parameters. For more 
on each symbol options choose Help | 
Help Topics 

Sample Symbol will change with your selections. 
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Add a letter marking to the yellow diamond  

1. In the ToolBox, double-click on the yellow diamond symbol. 
The Symbol Options dialog box displays. 

2. Select the Symbol Shape tab. 

3. For Letter Marking enter an uppercase E. 

4. Stay in the dialog box. 

 

 

 

 

 

 

Change the line pattern, marking, marking color and size of the yellow diamond  

1. Click the Color/Pattern/Size/Shadow tab. 

2. Change Line Pattern to 4. 

3. Change Marking to 3. 

4. Change Mark Color to Orange. 

5. Change Override Size to 2.5. 

6. Stay in the dialog box. 

• All red triangles on the schedule and in 
the legend have changed to a black 
vertical bar.  

• The date is no longer showing on the 
black vertical bar. 

• The black vertical bar’s text is now cen-
tered on the bar. 

• Now, only the black vertical bar’s text is 
white. 

Changed Symbol 
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When in the Symbol Options dialog note the other tabs containing the following options. 

• Default Text tab: Add text that will display each time the symbol is added to the schedule. 

• ValueSet Default tab: Assign to a Symbol ValueSet a value that will be added to the ValueSet each time the symbol is added to the 
schedule.  

Change date format, text format and vertical position of the yellow diamond. 

1. Click the Text/Date Properties tab. 

2. Under Text Background Box check on Fill area around text. 

3. Under Text Background Box check on Draw Border. 

4. Under Text Background Box for Fill Color choose Light Yellow.  

5. Change Symbol Position to 1 level up from middle. 

6. For Symbol Date Format Override type in MMM. d. 

7. Choose OK.  

8. Double click on the blue circle symbol in the ToolBox. Follow 
steps 1 and 5 above to change its Symbol Position.  

Here is the resulting schedule. 

To see how to set other custom date for-
mats choose the Question Mark icon. 

The yellow diamonds now have : 

• An E in in their center. 

• They are marked with an or-
ange box around them. 

• Their text has been highlighted 
with a frame and color. 

• Their date has a different for-
mat based on the code en-
tered. 

Changed Symbol 

Select the Color/Pattern/
Size/Shadow tab, in the Sym-

bol Options dialog so symbols 
can have an after status color 
and /or an after status symbol. 
Symbol: Fill to Status needs to 
be checked on for these op-
tions to display.  
Dates | Date Related Settings 
|Symbol: Fill to Status  

Any bitmap can be used as a Milestones symbol. Bit-
map symbols must reside in the folder which contains 
all user-defined symbols. To add a bitmap symbol 
select the Symbol Shape tab, in the Symbol Options 
dialog.  Learn more Help |Help Topics | Bitmap. 
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Change a horizontal bar in the ToolBox 

As with symbols, when a bar in the ToolBox is changed, and that bar already exists on the schedule, all bars of that type 
which are on the schedule change as well. 

1. In the ToolBox, double-click on the green stiped horizontal bar. The 
Bar Options box displays. 

2. Change Bar Type to 2, wide bar. 

3. Change Fill Color to Blue. 

4. For Fill Pattern, scroll to the top most pattern Solid, select it. 

5. For Special  Effects scroll and choose Fade to Center (V). 

6. For Effects Target Color choose Lime. 

7.  Click OK. 

Horizontal bars can have an after status color. Under Sample Bar: select Bars: Fill to Status is On. Press to Change. The Sample Bar re-
flects the selection. Horizontal bars type’s numbers highlighted yellow ignore fill to status.  

Horizontal bars with arrowheads can have the arrow heads as Small, Normal or Large. 

Changed Horizontal Bar 
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Change  a vertical link in the ToolBox  

This schedule has just one vertical link.  These are customized similarly to the symbols and the horizontal bars: 

1. Double-click the first vertical link, in the ToolBox.  This Vertical Link Options dialog 
box displays. 

2. Change Color to Red. 

3. Change Line Pattern to 10, dashed line. 

4. Change Shape to  9, right jog with arrow head. 

5. For Arrowhead Type choose Normal. 

6. For Arrowhead Size choose Large. Global setting for all vertical links. 

7. Check on Adjust for chart symbol size. Global setting for all vertical links. 

8. Click OK. 

More Vertical links options. These are global setting for all vertical links. 
• Vertical links can be Shown on top over symbols and horizontal bars.  

• Vertical links can have Rounded Corners.  

• Vertical links can span multiple pages and can be drawn across those pages by selecting Draw 
lines for page spanning Vertical Connections. 

• Vertical links can have helpful connection bubbles, select  Draw Off-page Connection Bubbles. 

• Bubbles can be plain or 3-D (select  3-D Look for Bubbles), are drawn at the bottom and top of 
a page, and contain the connections task row number along the connections direction repre-
sented by an arrow. 

• Instead of a bubble the Vertical links can just have  a connection direction arrow, select Arrow 
Instead of Bubbles. 

Changed Vertical Link 
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Copy a ToolBox to paste into another schedule 

When two schedules are open in the same "instance" of Milestones, the user can copy one schedule's ToolBox and then 
paste it in the other schedule. Thus, the new ToolBox replaces the old ToolBox. All existing symbols, horizontal bar and ver-
tical links on the schedule are replaced by the symbols in the new ToolBox. 

1. Open both schedules in the same instance of Milestones (a single Milestones window with two files open). 

2. Right-click anywhere on the ToolBox 

3. Choose Copy ToolBox. 

4. Choose View | Window Controls | Switch Window menu and select the other schedule. 

5. Right-click that schedule's ToolBox and choose Paste ToolBox. 

Each time an independent Milestones window is opened, it is called an "instance."  Users can have multiple instances of Milestones open 
at a time.  Tell how many instances of Milestones are currently open by viewing the Windows Taskbar.   

To copy and paste between two schedules, the operation must take place within the same instance of Milestones.  When two schedules 
are open in the same instance of Milestones, it's possible to copy and paste the ToolBox and a ToolBox row from one schedule to the 
other. Choose File|Open to  brows to the files to share a ToolBox  or ToolBox row. 

Copy a ToolBox row within the same schedule 

1. Click the small plus next to the row to be copied.  This will select the row. 

2. Right-click the selected row and choose Copy Selected Row. 

3. Click the small plus next to the row to be changed.   

4. Right-click the selected row and choose Paste Copied Row over Selected. 

Copy a ToolBox row from one schedule to another: 
When two schedules are open in the same "instance" of Milestones, the user can copy one schedule's ToolBox row and 
then paste it in the other schedule.  If symbols, and horizontal bar from the original row are on the schedule they will be 
replaced by the new rows symbols and horizontal bar. 

1. Open both schedules in the same instance of Milestones (a single Milestones window with two files open). 

2. Click the small plus next to the row to be copied.  This will select the row. 

3. Right-click the selected row and choose Copy Selected Row. 

4. Choose View | Window Controls | Switch Window menu and select the other schedule. 

5. Click the small plus next to the row to be changed.   

6. Right-click the selected row and choose Paste Copied Row over Selected. 
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Open the schedule for this lesson 

1. On the toolbar, choose File.  

2. In the Files and Templates: Open and Save Options section 
select Open Samples or Lessons.  The Open a Sample Chart 
dialog displays. 

3. Under Select a Folder below to Open, select Lessons.  The Les-
son schedules will display in the window to the right. 

4. Pick Lesson 05 Starter Schedule.mlj.  

5. Save the schedule to an accessible folder on your computer. 
Choose the File tab.  In the Files and Templates: Open and 
Save Options section, choose Save As….  In the menu that dis-
plays choose Chart.  Name, then save the schedule. 

Set up dependencies for the project 
Here are the dependencies you are going to set up with vertical links for this schedule: 

• Once Plan is finished Design begins, then once Design is finished Manufacture begins. 

• Test can’t be started until Design is finished. 

• Market can’t be started until Test is finished. 

Add a Vertical Link from "Plan" to "Design" and "Design" to "Manufacture" 

There are three methods to add vertical links. Method 1- the insert menu. 

1. Click  the () Arrow tool in the toolbox. 

2. Click once on the black vertical link in the Toolbox. 

3. While holding the Shift key on the keyboard, click once on the word Plan, 
and then once on the word Manufacture.  Now, release the Shift key.  The  
Plan, Design and Manufacture task rows should be highlighted in black. 

4. Next click the Insert tab. 

6. In the Vertical Links section select Vertical Links between selected 
task rows.  The Create Vertical Links/Dependencies dialog box dis-
plays. 

7. For Type of Symbols to Link choose Link normal symbols. 

8. For Direction to Link choose Downward. 

9. For Type of Link choose (FS) - Finish to Start (connects the end sym-
bols on one task row to the start symbols on the next task row). 

10.Check on Display Vertical Task Links. 

11.Select OK. Then  click away from the schedule to de-select. Vertical 
links will be added.  

By default in this schedule vertical links are 
turned on. View |Optional Items | Task Links.  

In this lesson you will learn how to: 

• Set up dependencies for a project 

• Add dependencies across multiple pages. 

• Adjust tasks and the entire schedule using Shift All 
Dates 

• Adjust the schedule using dependencies 

Lesson 5 – Work with dependencies 

Highlighted Tasks 

Added Vertical Links 

Lesson 5 Starter Schedule 
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Add a vertical link From "Design" to "Test" 
The second method for adding a vertical link is using the 
Toolbox. 

1. Click the (+) Plus tool in the Toolbox. 

2. In the schedule, click once on the end symbol of Design 
(gold upside down triangle). It will highlight with a box 
around it. 

3. In the Toolbox, click the red vertical link. 

4. In the schedule, click once on the start symbol of Test 
(gold triangle). The vertical link will be added. 

Add a vertical link From "Test" to "Market" 

The third method for adding vertical links  is using the Toolbar.  This is the most effective option to insert a vertical link 
across multiple pages of a schedule. 

1. Click  the () Arrow tool in the toolbox. 

2. Select the blue dashed vertical link in the Toolbox. 

3. On the schedule select the end symbol of Test (white upside down triangle.)  This is considered the From Symbol of the 
vertical link. 

4. The Toolbar changes to the Selection tab.  At the bottom of the toolbar choose the Vertical Links tab. 

5. In the Create New Vertical Link section of the toolbar, select the Set button next to the 
From Symbol location.  (Milestones notes the row the symbol is on and the symbol’s 
order number on the row.)  Once the Set button is selected, the From Symbol locations 
will be highlighted in green. 

6. On your schedule select the start symbol of Market  (the white triangle).  This is consid-
ered the To Symbol of the vertical link.  

7. The toolbar changes to the Selection tab.  The Vertical Links tab should be selected.  If 
not, select it. 

8. In the Create New Vertical Link section of the toolbar, select the Set button next to the 
To Symbol location (Milestones notes the row the symbol is on and the symbol’s order 
number on the row.)  Once the Set button is selected the To Symbol locations will be 
highlighted in green. 

9. To complete the connection select the Connect Now button.  
The vertical link will be added. 

 

 Added Blue Vertical Link, Test to Market 

From Symbol Set Buttons 

To Symbol Set Buttons 

Added Red Vertical Link, Design to Test 

All Vertical Links  



5-3 

 

Adjust the schedule using dependencies 

Turn on Dependency Mode 
Dependency mode is a global setting which controls whether or not dependent symbols will move when a parent symbol 
moves. 

1. Click the Dates tab. 

2. In the Date Related Setting section check on Dependency Mode. Now dependent symbols will move when a parent sym-
bol moves. 

Adjust the schedule 
The schedule shows the Plan stage to be completed the week of March 5th the actual day 
March 7th.  However, the Plan stage will finish one week late, the week of March 12th, the 
actual day March 14th. 

1. Click the () Arrow tool. 

2. Click on the end date symbol for Plan.  The toolbar changes to the Selection tab Current 
Object: Symbol. 

3. In the first section of the Toolbar select the Calendar icon next to the symbol’s date. A cal-
endar displays. 

4. Click March 14th on the calendar.  All of the dependent tasks have shifted forward by the 
same amount of time. 

Change the length of "Design" 
Since the Plan stage has slipped we’ll cut 1 week from the 
Design step. 

1. Click  the () Arrow tool in the toolbox. 

2. Click and drag the end date symbol of Design to the left. 

Release the mouse when the symbol is on  March 30th. All 
of the dependent tasks have shifted Backwards by the 
same amount of time. 

Adjust the entire schedule using Shift All Dates 

Suppose an entire project schedule needs to be moved forward because it cannot start at the scheduled time.  One option 
is to use the shift all dates option. 

To shift the entire schedule use Shift All Dates. 

1. Click the Dates tab. 

2. In the Date Range Tools section choose Shift all tasks 
dates.  The Shift all Dates for Schedule dialog box 
displays. 

3. For Number of Working Days to Shift, enter 45. 

4. Select Forward so that it is selected. 

5. Uncheck Reset Schedule Start and End Dates by the 
Same Amount. 

6. Uncheck Shift Curtain Dates by the same amount. 

7. Click OK.  The schedule has been shifted ahead 45 
days. 

The date will display next to the cursor as the 
symbol is moved or view the status bar at the 

bottom left of the Milestone’s window to see the date 
as the symbol moves. 

Adjusted Schedule After Using “Shift all Dates” 

Adjusted Schedule 
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Open the schedule for this lesson 

1. On the toolbar, choose File.  

2. In the Files and Templates: Open and Save Options section 
select Open Samples or Lessons.  The Open a Sample Chart 
dialog displays. 

3. Under Select a Folder below to Open, select Lessons.  The 
Lesson schedules will display in the window to the right. 

4. Pick Lesson 06 Starter Schedule.mlj.  

5. Save the schedule to an accessible folder on your computer. 
Choose the File tab.  In the Files and Templates: Open and 
Save Options section, choose Save As….  In the menu that 
displays choose Chart.  Name, then save the schedule. 

Set up Indenting for a column  

The Indent/Outdent tools icons make it easy to change the outline level of each task. 

1. Click  the () Arrow tool in the toolbox. 

2. Click on the PROJECTS column heading.  The toolbar will change to the Selection tab with Current Object : Column Head-
ing.  

3. Select Switch to Column. 

4. In the Column Type and Format section, under Indent per Outline Level type in 0.2. 

5. Then click the apply button. The column will now be indented when outlined.  Right now, there is no difference on 
the schedule. You will outline the task rows in the next section of this tutorial. The task row indented  to level 2 will in-
dent .2.  The next task row indented to level 3  will indent .2 plus .2 more and so on. 

Lesson 6 Starter Schedule 

To have the keyboard Tab key used for indenting choose Tools | Program Options | Edit |Use TAB key for Outlining. 

 

In this lesson you will learn how to: 

• Set up indenting for a column. 

• Outline the steps in the project. 

• Set summary bar options. 

• Collapse and expand tasks. 

• Organize the schedule using WBS numbering. 

Lesson 6 - Outline a schedule 
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Outline the steps in the project 

Indent selected tasks from Outline Level 1 to 2. 

Indent the project steps under each street address, changing their outline level from 1 to 2.   

1. Click  the () Arrow tool in the toolbox. 

2. Holding the keyboard Ctrl key down, in the PROJECT column, click 
once on each of the project steps that is not an address.  When 
selected, the task row will highlight and the toolbar will change to 
the Selection tab with Current Object: Task Row. 

3. Click once on the Indent icon in the toolbar. These steps are 
now at outline level 2. 

4. Click within the schedule area to de-select the project steps.  No-
tice that the tasks which are now outline level 2 are shaded differ-
ently.  This schedule is set up with outline shading  (shading will be 
different for each outline level.) 

Indent selected tasks from Outline Level 2 to 3. 

1. Click  the () Arrow tool in the toolbox. 

2. Holding the Ctrl key down, click once on Pool Plumbing and once 
on Hook-up Water for each street address.  When selected, the 
task row will highlight and the toolbar will change to the Selection 
tab with Current Object: Task Row. 

3. Click once on the Indent icon on the toolbar.  These steps are 
now at outline level 3.  

Notice that on the level 1 and 2 tasks, no schedule infor-
mation was added for these tasks.  Now that the task are 
indented Milestones Professional’s Summary Bar Setting 
options can be set to draw the summary information.  In 
the next section of the tutorial you will turn on Summary 
Bar Setting options. 

Highlighted Schedule 

Indented Schedule 

Some schedules (like this one) use outline level shading.     
To change task row colors and attributes based on out-
line level, choose Format | Gridlines | Gridlines Shading, 
Font Sizes by Outline Level. 

4. Click within the schedule area to de-select the pro-
ject steps.  Notice that the tasks which are now out-
line level 3 are shaded differently.  This schedule is 
set up with outline shading  (shading will be differ-

Highlighted Schedule 

Indented Schedule 
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Set summary bar options 

Draw a single summary bar for all lower level symbols.  

1. Choose the Layout tab. 

2. In the Other section, choose Summary Bar Settings.  The Summary 
Bar Settings dialog box will display. 

3. Under When to Draw, select the Always option. 

4. Under For Normal Summary Bar Symbols and Bars for the Starting 
Symbol: select the down arrow and choose the third symbol (gold 
triangle pointing left.) 

5. Under For Normal Summary Bar Symbols and Bars, for the Bar: se-
lect the down arrow and choose the  second bar (thin black bar.) 

6. Under For Normal Summary Bar Symbols and Bars, for the Ending 
Symbol: select the down arrow and choose the fourth symbol (gold 
triangle pointing right.) 

7. Click OK.   

 

Now, on the top level summary bars a start symbol has been 
added at the first start date of the lower level tasks, connected 
with a horizontal bar, to a finish symbol placed at the last date 
of the lower level tasks. 

 

 

 

 

 

 

 

 

Have lower level symbols and bars rollup to the summary level  

In the Summary Bar Settings dialog box, check on Split Summary Bars 
using Lower Level Symbols/Bars. 

Have only lower level symbols rollup to the summary level. 

In the Summary Bar Settings dialog box, choose check on Split Sum-
mary Bars using Lower Level Symbols/Bars and check on Show Sym-
bols Only. 

Schedule with Summary Bars 

Summary with Lower Level Symbols and Bars 

Summary with Only Lower Level Symbols  



6-4 

 

Collapse and expand tasks 

Turn on the Collapse/Expand Indicators 

1. Click View tab. 

2. In the Optional Items section check on  Collapse/Expand Indicators. 

Indicators will be displayed beside every summary task in the left column closest to the schedule area.       

Collapse “301 Sunspot” using the Collapse/Expand Indicator 

1. Click  the () Arrow tool in the toolbox. 

2. Click the Collapse/Expand Indicator to the right of 301 Sunspot. 

Collapse "Plumbing" under “455 Tombstone” using the right-click menu 

1. Right-click once on the word Plumbing.  A menu will display. 

2. Choose Collapse Selected Task Row. Once collapsed the options will change to Expand Selected Task Row 

Expand all project steps at once 

1. Click the View tab. 

2. In the Other section choose Show all Task Rows. 

 

In Tools |Program Options |General  change the look (size, color, and/or shape) of the Collapse/Expand Indicators. 
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Organizing a schedule using WBS numbering 

A WBS (Work Breakdown Structure) SmartColumn displays the outline level as 1, 1.1, 1.1.1,... instead of the Outline Level 
SmartColumn levels of 1, 2, 3,...   A WBS number combines the task number and outline level into one number.  Task 1 
would have WBS number “1”, Sub-task 1 of Task 1 would have WBS number “1.1”, Sub-task 2 of Task 1 would have "1.2", 
and so on.  Other options for WBS numbering are also available but for this lesson you will stick with the default. 

1. Select the () Arrow tool in the toolbox. 

2. Click on the word PROJECTS.  The column 
heading will highlight. 

3. Select the Insert tab. 

4. In the Rows, Columns section, choose 
New Column. 

5. From the menu, choose WBS Number.  
The Starting WBS Number dialog box dis-
plays. 

6. In the Starting WBS Number dialog box, 
for the Starting WBS Number enter 1. 

7. Click OK and OK. 

Schedule with WBS Column 

The Starting WBS Number dialog allows cus-
tomized WBS for each outline level (up to 20 
levels). The WBS can be displayed as num-
bers or letters (lower or upper case.)  



7-1 

 

Open the schedule for this lesson  

1. On the toolbar, choose File.  

2. In the Files and Templates: Open and Save Options section 
select Open Samples or Lessons.  The Open a Sample Chart 
dialog displays. 

3. Under Select a Folder below to Open, select Lessons.  The Les-
son schedules will display in the window to the right. 

4. Pick Lesson 01 Starter Schedule.mlj.  

5. Save the schedule to an accessible folder on your computer. 
Choose the File tab.  In the Files and Templates: Open and 
Save Options section, choose Save As….  In the menu that dis-
plays choose Chart.  Name, then save the schedule. 

Symbol and Bar Fill To Status Date 

When Fill to Status Date is turned on for symbols and horizontal bars, the symbols and bars are filled with their defined 
colors up to the status date for the task.  (By default, this is the current date).  After the status date, they are hollow or use 
a user specified after status color to indicate future, incomplete activity. 

The current date for the example schedule is 3/21/20.  The current date is illustrated by the vertical dotted line on the 
schedule.    

Turn on Fill to Status Date 

1. Click the Dates tab. 

2. In the Date Related Settings check on 
Symbols: Fill to Status Date.    

3. In the Date Related Settings check on 
Bars: Fill to Status Date.    

Lesson 7 Starter Schedule 

In this lesson you will learn how to: 

• Turn on Symbol and Bar Fill To Status Date. 

• Customize after status properties. 

• Define a status symbol in the toolbox  

• Show ahead or behind using a status symbol 

• Add a % complete column with a % indicator symbol 

• Change task status by changing the % complete value 

• Set % complete for individual bars and symbols 

• Add a % complete value to a task in the schedule area 

Lesson 7 - Show Progress 

Symbols and Bars Filled to Status Date 
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Define a status symbol in the toolbox  

Project tasks may need to indicate one or more of the steps as ahead or behind schedule.  A "status" symbol is one way of 
controlling how much each task is ahead or behind.  A status symbol can be any symbol in your toolbox. 

1. In the toolbox, double-click the black diamond symbol. The  Symbol Options dialog box displays. 

2. On the Symbol Shape tab, click the button next to Status Symbol (used for Percent Complete) so that it is selected.   

3. Click OK.  

Show ahead or behind using a status symbol 

Change "Prototype" to be Behind Schedule 

1. Click the (+) Large Plus tool in the toolbox. 

2. In the toolbox, click once on the black diamond sym-
bol, it will highlight. 

3. Move your cursor to the Prototype task row in the 
schedule area between the red 2/11 triangle and the 
blue 4/24 circle. 

4. Click and hold the left-mouse button, and 
then drag until you see the 3/9/20 date 
next to the cursor (as shown) or in the 
status bar at the bottom left of the mile-
stones window.   

5. Release the mouse button to add the status symbol. 

Customize the after status properties 
The incomplete portion of the bar (after status) can be filled with a color other than white.  After status symbols can be 
filled with a color or be a different shape.  When complete, the symbol will change back to the original symbol in the 
toolbox. 

1. In the toolbox, double-click the yellow bar.  The Bar Op-
tions dialog box displays. 

2. Under AFTER STATUS (Incomplete): Fill Color: select the 
color rectangle to open the color palette and choose red. 

3. Press OK.  The incomplete portion of the bar is now red. 

4. In the toolbox, double-click the upside down red triangle 
on the right.  The Symbol Options dialog box will display. 

5. Choose the Color/Pattern/Size/Shadow tab. 

6. Select the color rectangle below After Status (incomplete) 
Color to open the color palette and choose blue.   

7. Change the After Status (incomplete) Shape:  to shape #4 
(a circle).  

8. Click OK.  The symbols which are after the status date (incomplete) have changed to a blue circle.  Once the task is com-
plete the bar will fill in yellow and the blue circle will become a red upside down triangle, like the Product Concept task.  

The S next to the crosshairs cursor indicates 
that you are about to add a Status Symbol. The % 
next to the cursor reminds you that the status 
symbol controls percent complete. 

Custom After Status Shape and Color 

The symbols available for the after status shape are the sym-
bols from the toolbox. 

Status Symbol Added 
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Change "Refine & Redesign" to be Ahead of Schedule then complete. 

1. In the toolbox, click the (+) Large Plus tool in the toolbox. 

2. In the toolbox, click once on the black diamond symbol, it will highlight. 

3. Click and drag to add the status symbol on 4/18/20 to the Refine & Redesign task row. Refine & Redesign is now ahead 
of schedule. 

4. Select the () Arrow tool in toolbox.  On the schedule, in the Refine & Redesign select the 

black diamond.  The toolbar is now active for that symbol.  In the toolbar, select the calendar 

icon and change the symbol’s date to 5/15/20.  The task is now complete, the entire bar will be 

colored yellow and the blue circle will change back to the original symbol (a red triangle). 

Add a percent complete column with a percent indicator symbol  

1. Click the Insert tab. 

2. In the Rows, Columns section choose New Column. 

3. From the menu choose Percent Complete.  The Percent Com-
plete Settings dialog box displays. 

4. Under Display Settings check on Include Percent Complete Sym-
bol in column. 

5. Under Display Settings choose Symbol on Right. 

6. For Symbol Size, scroll to 2.00. 

7. For accurate percent complete. In Updating Percent Complete 
section check on Allow Hourly Accuracy Date/Time Settings and 
Allow Minute Accuracy Date/Time Settings.   

8. Select OK. Then OK again.  A percent complete column with per-
cent values and pies will be added. 

Percent Complete Column with Values and Pies 
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Change task status by changing the percent complete value 

1. Click the (T) Text tool in the toolbox. 

2. On the Prototype task row in the % complete cell click 
and backspace through the 37% Complete. 

3. Type 75. 

4. Press Enter on the keyboard. 

The Prototype percent complete pie symbol has changed to 
reflect 75% complete and the bar on the schedule is now 
shaded to 75%.  Also, the 
status date has changed 
from 3/9 to 4/6. 

Adjust Status Using % Complete Column 

Set percent complete for individual bars and symbols 

Bars and symbols can have percent complete assigned to them.  This option is usually used when there our multiple task on 
a single task row as shown in the picture below.  

For this tutorial we will continue using the current schedule and change the percent complete for the Software Develop-
ment task. 

1. Click the () Arrow tool in the toolbox. 

2. On the Software Development task row click the white triangle on 5/4, it will highlight with a box around it. The toolbar 
at the top of the Milestones window is now active for that symbol as the Selection tab with Current Object: Symbol.  

3. Choose the small Size/Color tab at the bottom of the toolbar. 

4. In the Override Symbol and Bar Colors section in the box next to 1st Bar Fill 
%  select the drop down arrow scroll to 50% and select it. The 5/4 triangle 
symbol will now be colored red and the bar will be filled yellow to 50%. 
Note the percent complete column does not change. To have the percent complete column calculate when individual 
bar’s % is set the option Split Duration Across Bars needs to be turned on. 

Turn on Split Duration Across Bars option. 

1. Right-click the % Comp. column’s heading  

2. Choose Properties.   

3. In the Column Properties dialog, click the Properties button.   

4. At the bottom of the Percent Complete Settings dialog box check on Split Duration Across Bars. 

There is another way to change the status for a task:  Click the 
Arrow tool in the toolbox.  Then click and drag the status symbol 
to the updated location.  The percent complete reading will 
change to match the new status symbol placement. 

Multiple Tasks on a Task Row with Individual % Complete 

If two bars originate from a symbol for the sec-
ond bar’s percent override select 2nd Bar Fill %. 
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Add a % complete value to a task in the schedule area 

1. Click the () Arrow tool in the toolbox. 

2. On the Software Development task row click the red triangle on 5/4, it will highlight with a box around it. The toolbar at 
the top of the Milestones window is now active for that symbol as the Selection tab with Current Object: Symbol.  

3. Choose the small Text tab at the bottom of the toolbar. 

4. In the Text section next to Line 1: enter  
&percentcomplete 

5. Press the Apply Text Changes button.  50% will now 
display above the triangle. 

 
 

For multiple tasks on a single task row follow the above 
direction, however type &barfill1percent %. 
If two bars originate from a symbol for the second bar’s 
percent type &barfill2percent %. 



8-1 

 

If you manage multiple schedules, you will find Milestones Professional’s Hyperlinks feature very valuable.  A Hyperlink is a link from any 
symbol, task row, picture and Freeform text on the schedule to any other schedule, document, or web page. 
In addition to Hyperlinks, Milestones supports “symbol links.”  With symbol links a symbol’s date on one schedule can be based on a sym-
bol’s date on another schedule.  (Symbol links can also be used to link symbols within a single schedule.) 

Open the schedule for this lesson 

This lesson will show you how to maintain a "hub" schedule that links to most aspects of a project's world. 

1. On the toolbar, choose File.  

2. In the Files and Templates: Open and Save Options section select Open Samples or Lessons.  The Open a Sample Chart 
dialog displays. 

3. Under Select a Folder below to Open, select Lessons.  The Lesson schedules will display in the window to the right. 

4. Pick Lesson 08 Starter Schedule.mlj.  

5. Save the schedule to an accessible folder on your computer. Choose the File tab.  In the Files and Templates: Open and 
Save Options section, choose Save As….  In the menu that displays choose Chart.  Name, then save the schedule. 

6. Follow the instructions above to open and save Lesson 08 
Web Site Project.mlj,  for use later in the tutorial. 

7. For this tutorial to work back and forth between the sched-
ules go to View| Window Controls | Switch Window. 

In this lesson you will learn how to: 

• Add, activate, remove a symbol Hyperlink  to a file or 
URL 

• Add, activate, remove a task row Hyperlink  to a file or 
URL 

• Add a symbol link between schedules. 

Lesson 8 - Symbol HyperLinks and 
Symbol Links 

Lesson 8 Starter Schedule 

Lesson 8 Web Site Project 
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Activate a file or URL which has been Hyperlinked to a symbol 

1. The Lesson 08 Starter Schedule.mlj should still be the active schedule.  (If not, use View | Window Controls |Switch 
Windows .) 

2. Click the () Arrow tool in the toolbox. 

3. Right-click on the Web Project symbol with the Hyperlink icon.  This brings up the right-click menu. 

4. In the All Hyperlinks Dialog section, choose Hyperlink: Lesson 08 Web Site Project to launch the Lesson 08 Web Site Pro-
ject schedule.  

5. Right click the Web Project symbol again. In the All Hyperlinks Dialog section and choose Hyperlink: http://
www.kidasa.com to launch the KIDASA Software, Inc’s web site.  

Remove Hyperlinks from a symbol  

1. Choose the View tab.  In the Window Controls section, choose Switch Windows.  Then choose the Lesson 08 Starter 
Schedule to make it the active schedule.   

2. In the Marketing task row click the Web Project symbol.  The toolbar will change to the Selection tab with Current Ob-
ject: Symbol.   

3. At the bottom of the toolbar choose the Hyperlinks tab.  

4. In the Hyperlinks Option section select the Lesson 08 Starter Schedule.mlj from the drop down list. 

5. Click the Break Link button to remove the link. Now Lesson 08 Starter Schedule.mlj path is no longer 
shown in the drop down. 

6. Now Remove the http://www.kidasa.com hyperlink by selecting it. 

7. Click the Break Link button to remove the link. Now http://www.kidasa.com path is no longer shown in 
the drop down and the Web Project symbol does not have the Hyperlink icon any longer. 

Symbol Hyperlink  

Add a symbol Hyperlink to open another file or URL  

1. Choose the View tab.  In the Window Controls section, choose Switch Windows  then 
choose the Lesson 08 Starter Schedule.mlh to make it the active schedule.   

2. Click the () Arrow tool in the toolbox. 

3. In the Marketing task row click the Web Project red star symbol.  The toolbar will change to 
the Selection tab with Current Object: Symbol making it active for the symbol. 

4. At the bottom of the toolbar choose the Hyperlinks tab. 

5. In the Hyperlink Display section check on Highlight Symbols With Hyperlinks. 

6. Click the Add File button.  The Select the Document File to Link dialog box displays.  

7. Locate your saved Lesson 08 Web Site Project.mlh and select it, then choose Open.  The file path is now in 
the Hyperlinks drop down list and the Web Project symbol is highlighted with a Hyperlink icon. 

8. Now click the Add URL button. This displays the Add Internet or Intranet URL dialog box. 

9. Type in http://www.kidasa.com and press OK.  The URL is now in the Hyperlinks drop down list. 
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Hyperlink a file or URL to a task row 

Add a Task Row Hyperlink to open another file or URL  

1. The Lesson 08 Starter Schedule.mlh should still be the active schedule.  (If not, use View | Window Controls |Switch 
Windows .) 

2. Click the () Arrow tool in the toolbox. 

3. Click the word Marketing In the Department column.  The task row will highlight. The toolbar will change to the Selection 
tab with Current Object: Task Row. 

4. In the Hyperlink Settings section,  check on Show Hyperlink Icons. 

5. In the Hyperlink Settings section, choose the Add File button to see the Select the Document File to 
Link dialog box.  

6. Locate where you saved Lesson 08 Web Site Project.mlj and select it.  The file path is now in the drop down list and the  
Hyperlink icon is now displayed in the task row. 

7. Choose the Add URL button.  This brings up the Add Internet or Intranet URL dialog box. 

8. Type in http://www.kidasa.com and press OK.  The URL will now show up the Hyperlinks list. 

Activate a schedule or URL that has been Hyperlinked to a task row 

1. The Lesson 08 Starter Schedule.mlj should still be the active schedule.  (If not, use View | Window Controls |Switch 
Windows .) 

2. Click the () Arrow tool in the toolbox. 

3. Click the Hyperlink icon in the Marketing task row.  The Select Hyperlink to Launch dialog box displays, showing all 
Hyperlinks. 

4. Choose Lesson 08 Web Site Project’s file path to open Lesson 08 Web Site Project schedule or http://www.kidasa.com 
to open KIDASA Software, Inc’s website. Click OK to launch selected Hyperlink. 

Remove a Hyperlink from a task row  

1. Choose the View tab.  In the Window Controls section, choose Switch Windows. Then choose the Lesson 08 Starter 
Schedule to make it the active schedule.   

2. Click the () Arrow tool in the toolbox. 

3. Click the word Marketing.  The task row will highlight. The toolbar changes to the Selection tab with Current Object: 
Task Row.   

4. In the Hyperlink Settings section choose the down arrow to show list of hyperlinks for the task row. Select the Hyperlink 
to remove. 

5. Click the Break Link button to remove the selected Hyperlink. 

6. When all links are removed the Hyperlink icon will no longer appear in the task row. 

Freeform Text and Pictures can have a single URL or File Hyperlink. 
Add the Hyperlink by selecting either the Freeform Text or the Picture.  The toolbar is now active for the object selected. In the toolbar, in 
the Hyperlink field, type in the URL or File path.  Important press the update button. 
Right click the Picture to select then launch the Hyperlink. 
To activate the Freeform text Hyperlink check on Auto Launch option (in the toolbar near the Hyperlink field) to have the Hyperlink acti-
vate when the Freeform text is clicked. 
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Add a symbol link between schedules 

Name the Target Symbol  

The date of this target symbol will drive the date of any symbol whose outgoing link points to this target symbol. 

1. Choose the View tab.  In the Window Controls section, choose Switch Windows and then choose the Lesson 08 Web Site 
Project to make it the active schedule.   

2. In the task row Targeted Completion click on the red checkmark dated 1/24.  

3. The toolbar changes to the Selection tab with Current Object: Symbol making it active for the symbol.  At the bottom of 
the toolbar choose the Symbol Links tab. 

4. In the Incoming Links and Automation Tag section under Unique Symbol Name for Incoming Links-Used when this sym-
bol is a Link Target (white blank space), type in Web Site to name the symbol link. 

5. Press the Apply button. 

6. In the  Options section check on Highlight symbols with names or outgoing links. This attaches an icon to all 
symbols involved in symbol linking. 

7. Save Lesson 08 Web Site Project. (Important!) 

Establish the link 

1. Choose the View tab.  In the Window Controls section, choose Switch Windows then choose the Lesson 08 Starter 
Schedule to make it the active schedule. 

2. In the Marketing task row, click the Web Project on 1/11/ symbol.  

3. The toolbar will change to the Selection tab with Current Object: Symbol making it active for the symbol.   At the bottom 
of the toolbar choose the Symbol Links tab. 

4. In the Outgoing Link: the Target Symbol of the Link section, choose the Browse button.  Browse to where you saved the 
Lesson 08 Web Site Project.mlj and select it.  Select Open. The file path will now appear in the File Name box. 

5. The Symbol Name box will expand. If it doesn’t, click the down arrow and choose Web Site (the name given for the tar-
get symbol).  

6. Check on Update Symbol Links when Schedule is Opened.  Now, when a schedule with outgoing links is 
opened, those links are automatically updated with the latest target symbol dates. 

7. Check on Highlight symbols with names or outgoing links . This attaches an icon to all symbols involved 
in symbol linking. 

If Dependency mode (not turned on in the schedules being used for this tutorial) is turned on all dependent symbols of the linked symbol 
will also update unless Do Not Update Dependent Symbols (in the Options section of the toolbar) is selected for that linked symbol. 
 
If the target symbol has symbol text associated with it and the linked symbol should reflect the target symbol’s text. Check on Also up-

date this symbols text from the target symbol’s text in the Outgoing Link: the Target Symbol of the Link section for the toolbar. 
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Update the link 

Now that Web Project star symbol on 1/11(outgoing link) in Lesson 08 Starter Schedule.mlj file is linked to the red 
checkmark symbol on 1/24 (incoming link) in Lesson 08 Web Site Project.mlj file, thr Lesson 08 Starter Schedule.mlj file 
can be updated. The update will move the Web Project star symbol on 1/11 to 1/24(the date of the red checkmark symbol 
on in Lesson 08 Web Site Project.mlj). 

1. Choose the View tab.  In the Window Controls section, choose the down arrow next to Switch Windows and choose 
the Lesson 08 Starter Schedule to make it the active schedule. 

2. Choose the File tab. 

3. In the Master/Update section choose Update Master Schedule, Linked Symbols. 

4. Choose Linked Symbols. 

5. The Symbol Links Update Results dialog box appears. 

6. Press Ok to close the box. Now in Lesson 08 Starter Schedule.mlj, Web Project star symbol has been updated to 1/24. 

Linked 

In the Symbol Links Update Results dialog box all successfully updated symbols will have an Updated Successfully nota-
tion next to the target name. 

Schedule with Updated Symbol  
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Import Excel or  Spreadsheet information using Smart Import From Clipboard 

Importing into Milestones Professional file from a spreadsheet is easy with Smart Import From Clipboard.  

1. Open Milestones Professional.  Choose the File tab and select New. 

2. Choose New Empty Schedule. The Milestones default template will now be a schedule available for import.  

3. Open the spreadsheet for this lesson.  Note the file for this lesson is a called Smart Import Spreadsheet.  It is located in Program 
Files\KIDASA\Milestones Professional 2021\Samples\Lessons Folder. 

7. In the spreadsheet, choose Select All to select all information to be imported from the spreadsheet. 

8. In the spreadsheet choose Copy.  

9. In Milestones Professional choose the Connections tab. 

10.In the Excel section choose Import/Update from Excel. 

11.Choose Smart Import from Clipboard.  The Milestones Professional schedule will populate with the spreadsheet information. 
See results on the following page. 

 

Lesson 9 - Make a Schedule 
from Excel or a Spreadsheet 

In this lesson you will learn how to: 

• Import from the clipboard using Smart Import. 

• Copy then map spreadsheet data into specified areas 
of a Milestones Professional schedule. 

• Refresh the Milestones schedule from changed infor-
mation in the spreadsheet.  

 

IMPORTANT, for Smart Import From Clipboard to work: 

• The spreadsheet column headings must match the Milestones Professional schedule’s column headings exactly. 

• Date fields in the spreadsheet format must be in the default date order, such as m/d/y, that your computer uses. 

• The Unique ID field is not mapped to a column.  It is used to tag symbols for later refresh if the Excel information changes. The key 
is to set up a Unique Id field with the exact heading Unique ID and give each task a unique alpha and/or numeric string.  
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Smart Import From Clipboard Results 

• Single Row headings should always be set up in the Milestones Professional schedule and the spreadsheet when importing from a spread-
sheet. 

• To have percent complete be accurate, hourly minute detail must be turned on in Milestones.  Choose the Dates tab.  In the More Date 
Settings section click Hourly, Minute and Shift Settings.   Check on both  Allow Hourly Detail and Allow Minute Detail. 

• To have the task bars fill with color based on the percent complete, fill to status must be turned on.  Choose the Dates tab.  In the Date 
Related Settings section check on both  Symbols & Bars: Fill to Status Date 

• The 32th symbol in the toolbox becomes the status symbol.  Double click this symbol in the toolbox to change its properties. 

The Unique ID Field Generated Tags for All Symbols Cells And Columns for Later Refresh 

Milestones Schedule Generated from “Smart Import From Clipboard.” 
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Copy, then map Excel or spreadsheet data into specified areas of a Milestones Professional schedule. 

Open the schedule for this lesson  

1. On the toolbar, choose File.  

2. In the Files and Templates: Open and Save Options section select Open Samples or Lessons.  The Open a Sample Chart dialog 
displays. 

3. Under Select a Folder below to Open, select Lessons.  The Lesson schedules will display in the window to the right. 

4. Pick Lesson 09 Starter Schedule.mlj.  

5. Save the schedule to an accessible folder on your computer. Choose the File tab.  In the Files and Templates: Open and Save 
Options section, choose Save As….  In the menu that displays choose Chart.  Name, then save the schedule. 

Open the Excel  spreadsheet for this Lesson 

1. Open the spreadsheet for this lesson.  It is located in Program Files\KIDASA\Milestones Professional 2021
\Samples\Lessons\Spreadsheet.xls. 

2. Here is a snapshot of the information in the spreadsheet:    

Copy the Excel spreadsheet information to the clipboard 

1. In Excel select all information to be imported from the spreadsheet. 

2. In Excel choose Copy .  This will copy the Excel information to the Windows Clipboard. 

Lesson 9 Starter Schedule 

Before importing information from a spreadsheet into Milestones 
the best practice is to format your Milestones schedule first.   
This schedule was set up with: 

1. Baseline symbols. See tutorial Lesson 17. 

2. Summary bar information. See tutorial Lesson 6. 

3. Percent Complete SmartColumn. See tutorial Lesson 7. 

4. Status symbol (For importing from clipboard the status symbol is 
always the 64th symbol in the toolbox. Double click that symbol 
to set its style). 

5. Appropriate date range. 

6. Columns to import spreadsheet information into. 

7. Project column indented for outline level. See tutorial Lesson 6. 

8. Cost column set as a Values SmartColumn. 
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More about the Import Custom Format dialog. 

a. Fields from line 1 of input file are the fields from the Excel spreadsheet. Which will be mapped to... 

b. ...Field Usage in Schedule which are the Milestones fields. Pages 11 and 12 of this tutorial explain these Milestones fields. 

c. Black lines are the mapping of fields. 

d. Clear Settings deletes the black lines. 

e. Above the Fields’ Map is a picture of the Milestones schedule’s date headings and columns. The columns are numbered to help map fields in 
Excel to columns in Milestones correctly. 

f. For easier mapping of Excel information to columns in Milestones, the Milestones column headings are shown next to the column code. 

g. Once the columns are mapped, give the map a filter name by entering the name under Current Filter Name. 

h. Select  Save Settings to save the map. 

i. Once the map is saved make sure it is selected, then choose Continue Importing Current Filter.  This starts the import. 

j. Multiple maps filters can be saved.  The saved maps filter names will appear in the Current Filter Name list, which can then be selected for 
future imports. 

k. To use a saved map filter select its name and then select Retrieve Settings 

l. To delete saved map filters from list choose the name and then select Delete Name 

m. Export Filter and Import Filter options are available to share filters with other users. 

n. Once you have imported tasks into a Milestones schedule you can import further tasks into that same schedule by selecting Append Import-
ed Data. The new data will import below the old data. 

o. Once information is tagged in the Milestones schedule, the Milestones schedule can be updated when the Excel information changes. In 
order to have Milestones tag the Excel information during the import Tag imported data must be check on. 

Import  the data from the clipboard into your Milestones Professional schedule 

1. Move over to your Milestones Professional schedule. Choose the Connections tab. 

2. In the Excel section choose Import /Update from Excel. 

3. From the menu choose Custom Import From Clipboard.  The Import Custom Format dialog box displays. 

4. In the Import: Custom Format dialog box, you will map the spreadsheet fields to Milestones fields and columns.  

On the following pages you will be instructed on how to map the fields from Excel to the Milestones. 
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Import  the data from the clipboard into your Milestones Professional schedule (continued) 

Map the fields from the spreadsheet to the Milestones fields. 

1. If there are any black lines between the spreadsheet fields and the Milestones fields click the Clear Settings button.  This will 
erase any previous filter settings (map lines between fields). 

2. Under Fields from line 1 of input file, click once on Field 1: Outline. It will highlight.  

3. Under Field Usage in Schedule, scroll to Outline_Level, select it. It will highlight. The green active line shows the map. 

4. Under Fields from line 1 of input file, click once on Field 3: Task.  It will highlight. Note the green active line is now black. 

5. Under Field Usage in Schedule, scroll to Column_10_Left: Project (For easy mapping, column fields show the name of the col-
umns from the Milestones schedule), select it. It will highlight. The green active line shows the map. 

6. Under Fields from line 1 of input file, click once on Field 4: Start.  It will highlight. Note the green active line is now black. 

7. Under Field Usage in Schedule, scroll to Task _1_Start_Date, select it. It will highlight. The green active line shows the map. 

8. Under Fields from line 1 of input file, click once on Field 5: End.  It will highlight. Note the green active line is now black. 

9. Under Field Usage in Schedule, scroll to  Task _1_End_Date, select it. It will highlight. The green active line shows the map. 

The outline level field in Milestones will set the im-
ported task at the level specified in the spreadsheet.  
An indention of tasks based on the outline level 
should be set up for each Milestone column prior to 
import. In this tutorial the Project column was set up 
with an indention. 

If Milestones is to draw summary bars, as in this tuto-
rial, this also should be set up in the Milestones file 
prior to importing.  

When a spreadsheet field is mapped to a Milestones 
column the information from the spreadsheet field 
will populate the column. The Project column in Mile-
stones is a text column. Prior to import this column 
was set up to indent information imported based on 
the outline level as specified in the spreadsheet. 

For symbols and/or bars to populate a Milestones 
schedule the date fields from the spreadsheet need to 
be mapped to a Milestones Task or Milestones fields. 

The Task and Milestones fields import specific symbols 
from the toolbox, see page 10 in this tutorial. 

To have a bar drawn between symbols. The combina-
tion of the same numbered Task Start Date and Task 
End Date field must be mapped. 

The Task field combinations imports specific bars from 
the toolbox, see page in this tutorial. 

Milestones fields will not import a bar between sym-
bols.  Also selecting either a Task Start Date or End 
Date and not its numbered pair will import as a mile-

stone. 
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Import  the data from the clipboard into your Milestones Professional schedule (continued) 

10.Under Fields from line 1 of input file, click once on Field 6: Successors (see page 12 for more information). It will highlight.  

11.Under Field Usage in Schedule, scroll to Successors, select it. It will highlight. The green active line shows the map. 

12.Under Fields from line 1 of input file, click once on Field 7: Baseline Start. It will highlight.  

13.Under Field Usage in Schedule, scroll to Task _3_Start_Date, select it. It will highlight. The green active line shows the map. 

 

14.Under Fields from line 1 of input file, click once on Field 8 : Baseline End. It will highlight.  

15.Under Field Usage in Schedule, scroll to Task _3_End_Date, select it. It will highlight. The green active line shows the map. 

16.Under Fields from line 1 of input file, click once on Field 9: % It will highlight.  

17.Under Field Usage in Schedule, scroll to Percent_Complete, select it. It will highlight. The green active line shows the map. 

Successor information from a spreadsheet will display 
vertical links between tasks in the Milestones sched-
ule. 

How to format the spread sheet information for a 
successor.  In the origin symbol’s task row enter the 
task row number to where the link is going.  Note: 
The first task row in spreadsheet is counted as 0. 

Enter the direction of the link.  SF (Start to Finish) SS 
(Start to Start) FS (Finish to Start) FF (Finish to Finish).  

For symbols and/or bars to populate a Milestones 
schedule the date fields from the spreadsheet need 
to be mapped to a Milestones Task or Milestones 
fields. 

The Task and Milestones fields imports specific sym-
bols from the toolbox, see page 10 in this tutorial.  
For this tutorial Task _3 was selected because in the 
Milestones schedule, being used for import, the cor-
responding symbols in the toolbox were set as base-
line symbols. 

To have a bar drawn between symbols. The combi-
nation of the same numbered Task Start Date and 
Task End Date field must be mapped. 

The Task field combinations imports specific bars 
from the toolbox, see page 10 in this tutorial. 

Percent Complete information from a spreadsheet 
when mapped to Percent Complete Milestones field 
will display the percent complete of a task by estab-
lishing a status symbol on each task row thus allowing 
the fill to status options to be used. 
The fill to status options, the look of the status sym-
bol, and the symbol and bar fill colors should all be 
preset in the Milestones schedule before import.  
The spreadsheet percent information does not need 
to be mapped to the Milestones Percent column be-
cause in the Milestones schedule a Percent Complete 
SmartColumn has been established, that will auto-
matically pick up the percent information from the 
status symbol. 
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Import  the data from the clipboard into your Milestones Professional schedule (continued) 

18.Under Fields from line 1 of input file, click once on Field 10: Cost.  It will highlight.  

19.Under Field Usage in Schedule, scroll to Column_11_Right: Cost, (For easy mapping, column fields show the name of the col-
umns from the Milestones schedule), select it. It will highlight. The green active line shows the map. 

20.Under Fields from line 1 of input file, click once on Field 11: Unique ID. It will highlight.  

21.Under Field Usage in Schedule, scroll to UniqueID, select it. It will highlight. The green active line shows the map. 

22.Check on Tag imported Data.  

23.Under Current Filter Name, type My Filter. 

24.Click the Save Settings button. 

25.Click the Continue Import Using Current Filter 
button.  The schedule now contains the imported 
tasks and dates from the spreadsheet. See Next 
page for imported schedule. 

26.Save the imported schedule to use for the next 
part of this tutorial. 

 

When a spreadsheet field is mapped to a Milestones 
column the information from the spread sheet field 
will populate the column. The Cost column in Mile-
stones is a Values SmartColumn set up in the Mile-
stones schedule prior to import . 

Set up a column in the spreadsheet with each task 
having a unique alpha and/or numeric string.  The 
Unique Id will be used to tag imported symbols and 
column cell information for Refresh. The column 
headings will also be used  to tag symbols, and col-
umns. 
To insure proper Refresh never change the Unique ID 
of a task in the spreadsheet once the information is 
imported into the Milestones schedule. 
The spreadsheet Unique ID field must be mapped to 
the Milestones unique id field and the Tag imported 
data must be checked on. 
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Import  the data from the clipboard into your Milestones Professional schedule (continued) 

Refresh Imported  Milestones Professional schedule when Spreadsheet information changes. 

Because there was a Unique ID column in the spreadsheet (with each task having a unique alpha and/or numeric string) and that 
field was mapped to the Milestones Unique Id field the resulting schedule was tagged for Refresh. The Unique Id’s when mapped 
tagged symbols, and column cells with the Unique ID.  The column headings were also used in the tags of symbols and Milestones 
columns. Thus the imported schedule can now be updated if the excel spreadsheet changes.  
In this section of the tutorial we will use a changed spreadsheet to update the saved imported Milestones file. 

Open the Changed Spreadsheet for this Lesson 

1. Open the spreadsheet Spreadsheet Changed . It is located in Program Files\KIDASA\Milestones Professional 2019
\Samples\Lessons\ Spreadsheet Changed .  

2. Here is a snapshot of the information in the spreadsheet highlighting the changed items.  System Development’s task end date 
changed from 7/2/2021 to 8/2/2021, percent changed from 60% To 80%  and cost changed from $60,000 to $70,000. 

3. In Excel select all information in the spreadsheet. 

4. In Excel click Copy .  This will copy the Excel information to the Windows Clipboard. 

To insure proper Refresh never change the Unique ID of a task in the spreadsheet once the information is imported into the 
Milestones schedule. 

Excel Information Imported into Milestones Professional  
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Refresh Imported  Milestones Professional schedule when Spreadsheet information changes. (cont’d) 

Open the saved imported Milestones schedule. 

1. Choose the Connections tab   

2. In the Excel section choose Import/Update from Excel 

3. Choose Refresh from Clipboard.  The Refresh from the Clipboard  dialog displays. 

4. Choose the down arrow in the box next to Refresh Using.  A list 
of the column headings from the spreadsheet will display. 
Choose the column that contains the Unique ID’s.  For this tutori-
al the unique id’s were populated in the Excel column Unique ID 
so select UniqueID from the list. 

5. For Percent Complete check on Refresh Percent Complete.  

6. Select the down arrow  in the box below. A list of the column 
headings from the spreadsheet will display.   Choose the column 
that contains the percent complete values.  In this tutorial it is 
the column %. 

7. If information in columns of the spreadsheet have changed and those columns are in the Milestones schedule then check on 
Refresh tagged columns to have the columns in Milestones update with the new spreadsheet information. In this tutorial the 
Cost column will need to refreshed, therefore this option must be checked on. 

8. Choose OK. 

Note column headings do not have spaces between words. 
Upon import Milestones eliminates the spaces for tagging 
purposes. Symbol and column tags will not have spaces. 

If multiple start or finish symbols and/or symbol, bar 
symbol combinations are on a single task row in the 
Milestones schedule the option Update individual 
bars and symbols must also be checked on.  

Refreshed Milestones Professional  Schedule with Excel Changes Highlighted 
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Toolbox showing symbols and bars that import when Task Date fields are mapped 
 
 

When Task_1_Start_Date is mapped the symbol in symbol position 1 in the toolbox will display. 
Task_1_End_Date is mapped the symbol in position 2 in the toolbox will display.  
When Task_1_Start_Date and Task_1_End_Date are mapped the bar in bar position 1 will display. 
 
When Task_2_Start_Date is mapped the symbol in symbol position 3 in the toolbox will display. 
Task_2_End_Date is mapped the symbol in position 4 in the toolbox will display.  
When Task_2_Start_Date and Task_2_End_Date are mapped the bar in bar position 2 will display. 
 
When Task_3_Start_Date is mapped the symbol in symbol position 5 in the toolbox will display. 
Task_3_End_Date is mapped the symbol in position 6 in the toolbox will display.  
When Task_3_Start_Date and Task_3_End_Date are mapped the bar in bar position 3 will display. 
 
When Task_4_Start_Date is mapped the symbol in symbol position 7 in the toolbox will display. 
Task_4_End_Date is mapped the symbol in position 8 in the toolbox will display.  
When Task_4_Start_Date and Task_4_End_Date are mapped the bar in bar position 4 will display. 
 
When Milestone_Date_1 is mapped the symbol in symbol position 9 in the toolbox will display. 
When Milestone_Date_2 is mapped the symbol in symbol position 10 in the toolbox will display. 
When Milestone_Date_3 is mapped the symbol in symbol position 11 in the toolbox will display. 
When Milestone_Date_4 is mapped the symbol in symbol position 12 in the toolbox will display. 
 
When Task_5_Start_Date is mapped the symbol in symbol position 13 in the toolbox will display. 
Task_5_End_Date is mapped the symbol in position 14 in the toolbox will display.  
When Task_5_Start_Date and Task_1_End_Date are mapped the bar in bar position 5 will display. 
 
When Task_6_Start_Date is mapped the symbol in symbol position 15 in the toolbox will display. 
Task_6_End_Date is mapped the symbol in position 16 in the toolbox will display.  
When Task_6_Start_Date and Task_6_End_Date are mapped the bar in bar position 6 will display. 
 
When Task_7_Start_Date is mapped the symbol in symbol position 17 in the toolbox will display. 
Task_7_End_Date is mapped the symbol in position 18 in the toolbox will display.  
When Task_7_Start_Date and Task_7_End_Date are mapped the bar in bar position 7 will display. 
 
When Task_8_Start_Date is mapped the symbol in symbol position 19 in the toolbox will display. 
Task_8_End_Date is mapped the symbol in position 20 in the toolbox will display.  
When Task_8_Start_Date and Task_8_End_Date are mapped the bar in bar position 8 will display. 
 
When Task_9_Start_Date is mapped the symbol in symbol position 21 in the toolbox will display. 
Task_9_End_Date is mapped the symbol in position 22 in the toolbox will display.  
When Task_9_Start_Date and Task_9_End_Date are mapped the bar in bar position 9 will display. 
 
When Task_10_Start_Date is mapped the symbol in symbol position 23 in the toolbox will display. 
Task_10_End_Date is mapped the symbol in position 24 in the toolbox will display.  
When Task_10_Start_Date and Task_10_End_Date are mapped the bar in bar position 10 will display. 
 
When Task_11_Start_Date is mapped the symbol in symbol position 25 in the toolbox will display. 
Task_11_End_Date is mapped the symbol in position 26 in the toolbox will display.  
When Task_11_Start_Date and Task_11_End_Date are mapped the bar in bar position 11 will display. 
 
When Task_12_Start_Date is mapped the symbol in symbol position 27 in the toolbox will display. 
Task_12_End_Date is mapped the symbol in position 28 in the toolbox will display.  
When Task_12_Start_Date and Task_12_End_Date are mapped the bar in bar position 12 will display. 
 
When Task_13_Start_Date is mapped the symbol in symbol position 29 in the toolbox will display. 
Task_13_End_Date is mapped the symbol in position 30 in the toolbox will display.  
When Task_13_Start_Date and Task_13_End_Date are mapped the bar in bar position 13 will display. 
 
Continued on next page. 

To have a bar drawn between symbols. The combination of the same numbered Task Start Date and 
Task End Date field must be mapped.   



9-11 

 

Toolbox showing symbols and bars that import when Task Date fields are mapped (cont’d) 

When Task_14_Start_Date is mapped the symbol in symbol position 31 in the toolbox will display. 
Task_14_End_Date is mapped the symbol in position 32 in the toolbox will display.  
When Task_14_Start_Date and Task_14_End_Date are mapped the bar in bar position 14 will display. 
 
When Task_15_Start_Date is mapped the symbol in symbol position 33 in the toolbox will display. 
Task_15_End_Date is mapped the symbol in position 34 in the toolbox will display.  
When Task_15_Start_Date and Task_15_End_Date are mapped the bar in bar position 15 will display. 
 
When Task_16_Start_Date is mapped the symbol in symbol position 35 in the toolbox will display. 
Task_16_End_Date is mapped the symbol in position 36 in the toolbox will display.  
When Task_16_Start_Date and Task_16_End_Date are mapped the bar in bar position 16 will display. 
 
When Task_17_Start_Date is mapped the symbol in symbol position 37 in the toolbox will display. 
Task_17_End_Date is mapped the symbol in position 38 in the toolbox will display.  
When Task_17_Start_Date and Task_17_End_Date are mapped the bar in bar position 17 will display. 
 
When Task_18_Start_Date is mapped the symbol in symbol position 39 in the toolbox will display. 
Task_18_End_Date is mapped the symbol in position 40 in the toolbox will display.  
When Task_18_Start_Date and Task_18_End_Date are mapped the bar in bar position 18 will display. 
 
When Task_19_Start_Date is mapped the symbol in symbol position 41 in the toolbox will display. 
Task_19_End_Date is mapped the symbol in position 42 in the toolbox will display.  
When Task_19_Start_Date and Task_19_End_Date are mapped the bar in bar position 19 will display. 
 
When Task_20_Start_Date is mapped the symbol in symbol position 43 in the toolbox will display. 
Task_20_End_Date is mapped the symbol in position 44 in the toolbox will display.  
When Task_20_Start_Date and Task_20_End_Date are mapped the bar in bar position 20 will display. 
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Milestones import map: Fields in the Map and how they translate into the Milestones Schedule  

Task start and end date fields 
When mapped into the following Milestones fields, date information 
from a spreadsheet will display symbols connected with a bar or just a 
symbol in a Milestones schedule. 

When dates from columns in a spreadsheet are mapped into a combi-
nation of Task_#_Start Date and  Task_#_End Date fields (the # must 
be the same) , a start symbol, a bar and an end symbol are added to 
the schedule.   

When a date column from a spreadsheet is mapped to either the 
Task_#_Start Date or the  Task_#_End field a single milestone will be 
added to the schedule.  

 

 

Milestone Date Fields 

When mapped into the following Milestones Custom Fields, date information from a spread-
sheet will display individual symbols in a Milestones schedule. 

 

 

 

Task start and end date expanded date and time fields 
When mapped into the following Milestones Custom Fields, date and time information from a spreadsheet will display symbols 
connected with a bar or just a symbol in a Milestones schedule.  These symbols will be placed on the schedule at the date and time 
as specified in the spreadsheet columns for Year, Month, Day, Hour, Minute. 

When date and time information from columns 
in a spreadsheet are mapped to a  combination 
of Task_#_Start, Year, Month, Day Hour, Mi-
nute and Task_#_End, Year, Month, Day, Hour, 
Minute (the # must be the same) a start sym-
bol, a bar and an end symbol are added to the 
schedule.   

If only mapped to either the Task_#_Start, Year, 
Month, Day Hour, Minute or the Task_#_End, 
Year, Month, Day, Hour, Minute  fields a single 
milestone will be added to the schedule.  

 

Outline and WBS Field 

When mapped into the following Milestones  Fields, Outline Level and WBS, information from the  spread-
sheet will cause the tasks imported into the Milestones schedule to have outline characteristics.  

 

Milestones Date Fields 

When Milestones Professional imports from Excel it uses the symbols in the toolbox in a specific order.  See page 10 of this tutorial to see the 
toolbox symbols and bars associated with the Task Date fields. 

Date information in a spreadsheet must be formatted as: 
month/day/year. 

Milestone_Date_1 
Milestone_Date_2 
Milestone_Date_3 
Milestone_Date_4 

Milestones Single Date Fields 

Outline_Level 
WBS_Number 

Milestones Fields 

Milestones Date Fields 

To have the task indent based on WBS and Outline levels review Tutorial Lesson 6 to see how to set up 
the Milestones schedule. 

Date information in a spreadsheet must be formatted as: 
month/day/year. 
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Chart Title 

When mapped to the Chart Title field Milestones uses the text in the spreadsheet’s last cell of the column as the charts title. 

 

Successors Field 

When mapped into the Milestones field Successors, successor information from a spreadsheet will display vertical links between 
tasks in the Milestones schedule.  To accurately import successors, format the spreadsheet as follows: 

• Click in the cell within the successor field where the link is to start. 

• Enter the task row number for the successor of the link (the end symbol). Note: The first task row in a spreadsheet is count-
ed as 0. 

• Finally, enter the direction of the link.  Choose from one of the following options: SF (Start to Finish) SS (Start to Start) FS 
(Finish to Start) FF (Finish to Finish). 

 

Duration Field 

When mapped into the Milestones field Duration, duration information from a spreadsheet will display as a task bar with start and 
end symbols in the Milestones schedule.  

• A positive duration value in the spreadsheet is used to generate a task bar and an end symbol when the task’s start date is 
imported from the spreadsheet. 

 

Negative Duration Field 

When mapped into the Milestones field Negative_Duration, duration information from a spreadsheet will display as a task bar with 
start and end symbols in the Milestones schedule.  

• A negative duration value in the spreadsheet is used to generate a task bar and start symbol when the task’s end date is im-
ported from the spreadsheet. 

 

Percent Complete Field 

When mapped into the Milestones field Percent_Complete, Percent Complete information from a spreadsheet will display the per-
cent complete of a task by establishing a status symbol. 

 

Hyperlink 

A column of Hyperlinks in a spreadsheet can be mapped to the Milestones Hyperlink field to have the hyperlinks import into the 
task row of the Milestones file.  After the import the task rows with hyperlinks will be marked with the hyperlink icon, which can 
then be right clicked to select the Hyperlink option to view and launch the hyperlink. 

 

Unique Id  

Column set up in the spreadsheet with each task having a unique alpha and/or numeric string.  Used to tag imported symbols for 
Refresh . 

• To insure proper Refresh never change the Unique ID of a task in the spreadsheet once the information is imported into the 
Milestones schedule. 

Other Milestones Fields 
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Open the schedules for this lesson 

Open all three schedules used in this lesson. 

1. On the toolbar, choose File.  

2. In the Files and Templates: Open and Save Options section select Open Samples or Lessons.  The Open a Sample Chart 
dialog displays. 

3. Under Select a Folder below to Open, select Lessons.  The Lesson schedules will display in the window to the right. 

4. Pick Lesson 10 Starter Schedule.mlj.  

5. Save the schedule to an accessible folder on your computer. Choose the File tab.  In the Files and Templates: Open and 
Save Options section, choose Save As….  In the menu that displays choose Chart.  Name, then save the schedule. 

6. Repeat the above instructions and open Lesson 10 Project 1.mlj and Lesson 10 Project 2.mlj. 

7. Leave all three schedules open. 

8. To go back and forth between schedules, choose the View tab.  In the Widow Controls section, choose Switch Windows. 

Lesson 10 - Master Schedules 

Project 2 Schedule 

When working with Milestones, 
Master Schedule feature all sched-
ules should have the same format. 

Lesson 10 Starter Schedule 

 

In this lesson you will learn how to: 

• Create a master schedule from three sub-schedules. 

• Make changes to the sub-schedules, and then update 
the master schedule. 

 

Project 1 Schedule 
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Create a Master Schedule  

1. Use the View tab to select Lesson 10 Starter 
Schedule to make it the active schedule. 

2. Choose the File tab. 

3. In the Master/Update section choose Mas-
ter Schedule…, the Master Schedule Proper-
ties dialog box displays. 

4. Check on Treat the Current Schedule as a 
Master Schedule. 

5. Check on Automatically Update when Mas-
ter Schedule is Opened. 

6. Click the Add Schedule button. 

7. Locate where you saved Lesson 10 Project 
1.mlj and select it. 

8. Click the Open button.  Lesson 10 Project 
1.mlj path is now displayed in the Master 
Schedule Properties dialog. 

9. Click the Add Schedule button. 

10. Locate where you saved Lesson 10 Project 2.mlj and select it. 

11. Click the Open button. Lesson 10 Project 2.mlj path is now displayed in the Master Schedule Properties dialog. 

12. Choose OK to return to the schedule. Nothing appears in the master schedule until you update it. 

13. Choose the File tab. 

14. In the Master/Update section choose Update Master Schedule, Linked Symbols and then choose Master Schedule. 

15. The Master Schedule Update Results dialog box displays, showing which schedules were [Updated Successfully] or 
[Update Failed]. Choose OK to see the new schedule, containing the information from Project 1 and Project 2 schedules. 

16. Save the schedule. (Do not close) 

Master Schedule 
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Make changes to the sub-schedule Lesson 10 Project 1 then Update the Master Schedule. 

1. Use the View | Widow Controls  | Switch Windows to select Lesson 10 Project 1.mlj to make it the active schedule.. 

2. Click the () Arrow tool in the toolbox. 

3. Go to Team 1 - Task 2 task row, and click-and-drag the blue arrow status symbol to the date 2/6.  Notice the Percent 
Complete has changed to 100%. As well as the Summary percent's for Team 1 and PROJECT 1. 

4. Click in (T) Text tool the toolbox. 

5. In the Cost to Date column, on the Team 1, Task 2 cell, click on $600 and change it to 2000. Click out of the schedule. 
Notice the Funding Status symbols and Costs to Date values  have changed for the tasks Team 1-Task2, Team 1,  and 
PROJECT 1. Also the DataGraphs for Actual have changed. 

6. Save the schedule.  

Now that the Lesson 10 Project 1.mlj schedule has changed the Lesson 10 Starter Schedule.mlj which is now a Master 
Schedule needs to be updated. 

7. Use the View tab to select Lesson 10 Starter Schedule .mlj to make it the active schedule. 

8. Choose the File tab. 

9. In the Master/Updates section choose Update Master Schedule, Linked Symbols. 

10.Choose Master Schedule. 

11.The Master Schedule Update Results dialog box displays showing which schedules were [Updated Successfully] or 
[Update Failed]. Choose OK to see the new schedule.  See the next page to view the updated Master Schedule. 

Project 1 Schedule with Changes 
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• You only need to set up the master schedule once. 

• Changes in the master schedule do not appear in the sub-schedules. 

• When the underlying schedules are changed (and saved) and the master schedule is updated, the master 
schedule will reflect the most recent saved changes. 

• Schedules on other computers on your network can be referenced by a master schedule. 

• Because master and sub-schedules need to have the same format, it's best to use a template when initially 
creating all sub-schedules and the master schedule. 

Make changes to the sub-schedule Lesson 10 Project 1 then Update the Master Schedule. (continued) 

Notice that the changes made in the Lesson 10 Project 1.mlj schedule appear in the Lesson 10 Starter Schedule.mlj. Fund-
ing Status symbols and Costs to Date values  have changed for the tasks Team 1-Task2, Team 1,  and PROJECT 1. Also the 
DataGraph results for Actual in the months of January and February  have changed.   

Master Schedule with Changes 
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Open the schedule for this lesson  

1. On the toolbar, choose File.  

2. In the Files and Templates: Open and Save Options section, 
select Open Samples or Lessons.  The Open a Sample Chart dia-
log displays. 

3. Under Select a Folder below to Open, select Lessons.  The Les-
son schedules will display in the window to the right. 

4. Pick Lesson 11 Starter Schedule.mlj.  

5. Save the schedule to an accessible folder on your computer. 
Choose the File tab.  In the Files and Templates: Open and Save 
Options section, choose Save As….  In the menu that displays 
choose Chart.  Name, then save the schedule. 

Numbers can be shown along with a schedule.  These numbers can be contained in value categories called ValueSets (e.g. Manhours, 
Budget, and Costs) and then graphed on a DataGraphs, as well as totaled for each row (in columns).  

There are five different types of ValueSets possible with Milestones Professional.  In this lesson you will learn about Types 1, 2, and 3.  You 
will learn how to work with these ValueSet types, build a DataGraph and more. 

Up to 9 ValueSets can be added to a schedule.  They can be graphed on up to 3 DataGraphs, a maximum of 8 ValueSets per DataGraph.  

In this lesson you will learn how to: 

• Create a Type 1: Keyed-In Global Values ValueSet.  

• Create a Type 2: Sum of Values Keyed into a Task Row 
ValueSet.   

• Create a Type 3: Allocate Column Values Across a Time-
line ValueSet.  

• Enter the values for a ValueSet. 

• Set up DataGraphs which display the ValueSets. 

• Create a Values SmartColumn.   

• Enter values in the Values SmartColumn. 

Lesson 11 - Introduction to  
ValueSets and DataGraphs 

Schedule with DataGraph Generated from ValueSets 1,2, and 3 

Lesson 11 Starter Schedule 



11-2 

 

Create the Budget ValueSet as Type 1: Keyed-in Global Values   

First, create one Type 1 ValueSet.  These values are entered by specified time increments (daily, weekly, monthly, etc.) and 
do not relate to specific tasks.  Here, you will enter monthly Budget values for the whole project. 

1. Click the Tools tab. 

2. In the Graph Options section choose Set Up ValueSets.  The Create or Edit 
ValueSets dialog box displays. 

3. For the Set Alignment for ValueSets option choose Monthly as the time peri-
od to align the values. 

4. Click the first Create/Edit button to the left of 1: No Name Assigned …  The 
ValueSet Properties dialog displays.    

5. For ValueSet Name enter Budget.    

6. Under the Data Source tab, choose Type 1: Keyed-in Global Values as the ValueSet type. 

7. Click the Display/Edit Values... button.   The Edit Values dialog box displays.  

8. In the Edit Value dialog box enter the following val-
ues a monthly budget value in each cell under    
Value.   
February: 3000 
March: 4000 
April: 5500 
May: 5000 

9. Choose OK to return to the ValueSet Properties 
dialog box (keep this dialog box open for the next 
set of instructions.) 

 

The From date for row 1 is defined by the start date of this schedule (2/1/24).  The To date for row 1 is defined by alignment chosen 
in Step 3 (for this tutorial Monthly ). Thus, row 1 is February's budget, row 2 is March’s budget, and so on. The final date where a 
value can be entered is established by the end date of the schedule. If the end date is not the last day of a time increment selected a 
value can not be entered for the last time increment as seen in this tutorial. The last day of this schedule is 6/15/2024 therefore the 
last budget value that can be added is for May.  A June budget value can not be inserted because the entire month of June is not 
included in the date range of the schedule. 
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Create the Budget ValueSet as Type 1: Keyed-in Global Values cont’d 

10. Chose the Graphic Properties tab to set the ValueSet Display Properties and Graph Properties for Budget ValueSet. 
 
UNDER ValueSet Display Properties  

a. Check on Graph Values to have the Budget ValueSet 
values graph as bars, lines, or points in the DataGraph. 

b. Check on Values Represent Currency and the $ will 
display on all values for the Budget ValueSet in the  
DataGraph. 

c. Select 0 for Number of Decimals to Display.  All values 
for the Budget ValueSet will not show any decimal val-
ues. 

d. Check on Show Value Near Point. For this example the 
Budget ValueSet is going to be a point graph. For each 
month a point (represented by a symbol) will have the 
Budget value for that time increment displayed above 
the point (symbol). 

UNDER Graphic Properties  

a. Budget ValueSet values are going to be graphed as 
points.  Under Symbol for Point Graphs: select symbol 
4 green diamond with letter B.  The list of symbols 
available for points is a reflection of the toolbox. The 
green diamond was set up in the toolbox, see tutorial 
Lesson 4 for more information on setting up symbols in 
the toolbox.  
 
 
 

 
 
 

11. Click OK to return to the Create or Edit ValueSets dialog box 
(keep this dialog box open for the next set of instructions). 

Notice:  
Row 1. Budget. Contains 4 Values referencing  the 
values entered in step 8 on previous page. 
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Create the Cost ValueSet as Type 2: Sum of Values Keyed into Task Rows 

Next you will create a Type 2 ValueSet. These values are entered by specified time increments (this tutorial monthly) for a 
specific project task. Later, you will enter monthly Costs values for each of the project tasks. 

1. Click the Create/Edit button to the left of 2: No Name Assigned … to display 
the ValueSet Properties dialog  

2. For ValueSet Name enter Cost. 

3. Under the Data Source tab, choose Type 2: Sum of Values Keyed into Task Rows as the ValueSet type.      

4. Click the Graphic Properties tab to change the ValueSet Display Properties and Graph Properties . 

UNDER ValueSet Display Properties  

a. Check on Graph Values to have cause the Cost Val-
ueSet to be graphed. 

b. Check on Values Represent Currency.  The $ will 
display on all values for the Cost ValueSet in the  
DataGraph. 

c. Select 0 for Number of Decimals to Display.  No 
decimal places will be shown for values in the Cost 
ValueSet. 

d. Check on Show Values under Each Task Row. Be-
cause Cost is  a Type 2 ValueSet the values entered 
are associated with a task row.  The values can be 
displayed in their task row  by checking on this op-
tion. A Milestones message displays informing that 
the font used for these values is Symbol Text font To 
change choose Format |Default Text | Symbol Text. 

e. Check on Show Value Near Point. For this example 
the Cost ValueSet is going to be a point graph. For 
each month a point (represented by a selected sym-
bol) will have the Cost value for that time increment 
displayed. 

f. Check on Show value Below Point to have the Cost 
values display below the point (symbol). 

UNDER Graphic Properties  

a. Cost ValueSet values are going to be graphed as 
points.  Under Symbol for Point Graphs: select sym-
bol 3 red diamond with letter C.  The list of symbols 
available for points is a reflection of the toolbox. 
The red diamond that was set up in the toolbox, see 
tutorial Lesson 4 for more information on setting up 
symbols in the toolbox.  

5. Click OK to return to the Create or Edit ValueSets dialog box (keep this dialog box open for the next set of instructions). 

Notice:  
Row 1. Budget. Contains 4 Values.   
Row 2. Cost. Contains 0 Values. Values will be entered later. 
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Create the Manhours ValueSet as Type 3: Allocate Column Values Across Timeline 

Now, create a Type 3 ValueSet.  These values are taken from a Values SmartColumn,  evenly distributed across each task's 
Gantt bar, and graphed by time period in the DataGraph.  Here, the Manhours column will contain the values for this Man-
hours ValueSet. 

1. Click the third Create/Edit button to the left of 3: No Name Assigned … to reach 
the ValueSet Properties dialog box. 

6. Click the Graphic Properties tab to Set the ValueSet Display Properties and Graph Properties . 

UNDER ValueSet Display Properties  

a. Check on List Numeric Values above or Below Graph to have 
Manhours ValueSet values display in each time increment 
above the graph.  For values to display below graph select 
option when setting up the DataGraph. 

b. Check on Graph Values to have Manhours ValueSet values 
graph as bars, lines, or points in the DataGraph. 

c. Select 0 for Number of Decimals to Display.  All Values for the 
Cost ValueSet will not show any decimal values. 

UNDER Graphic Properties  

a. Manhour ValueSet values are going to be graphed as bars 
with a gradient from Silver to Black. Select the Line/Bar Color: 
Silver 

b. Select the Bar Pattern: solid which is the first option in the 
drop down 

c. Select the Solid Bar Target Color: Black 

d. Select the Solid Bar Effects: Fade to Bottom.  

7. Click OK to return to the Create or Edit ValueSets dialog box, where 
you should have these three ValueSets: Budget, Cost and Manhours 

8. Choose OK to return to the schedule.  You will not notice any change in the schedule. 

Row 1. Budget. Contains 4 Values.   
Row 2. Cost. Contains 0 Values. Values will be entered later. 
Row 3. Manhour. Contains 0 Values. Values will be entered later. 

2. For ValueSet Name enter Manhours. 

3. Under the Data Source tab, choose Type 3: Allocate Col-
umn Values Across Timeline as the ValueSet type.   

4. For Select Column scroll to 11. Manhours and select it. 

5. Check on Allocate to Current Date.  Values will only 
graph to the schedule’s current date. 
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Enter the Values for the "Costs" ValueSet 
The Costs ValueSet already exists, yet does not contain values. On a row-by-row basis, you will now enter those values. 

Enter the costs for the Research task row... 
1. Click the () Arrow tool in the toolbox. 

2. On the schedule, right-click the word Research, and from the right click menu choose Edit Val-
ueSet.  The Select ValueSet to Edit dialog box displays.  

3. Click the Edit button to the left of 2. Costs.   

4. The Edit Values dialog box appears.  Since Research takes place only in 
February and March enter 2000 for February and 1000 for March . 

5. Click OK, and OK again, to return to the schedule. You will see the values you 
entered in the Research task row however the graph will not appear yet. 

Enter the costs for Design... 

1. Right-click the word Design, from the right click menu choose  Edit 
ValueSet.  The Select ValueSet to Edit dialog displays.  

2. Click the Edit button to the left of 2. Costs. 

3. Since Design takes place only in March and April enter 2000 for 
March and 2000 for April. 

4. Click OK, and OK again, to return to the schedule. You will now 
see those values in the Design task row. 

Enter the costs for Prototype... 

1. Right-click the word Prototype, from the right click menu choose 
Edit ValueSet. The Select ValueSet to Edit dialog displays.  

2. Click the Edit button to the left of 2. Costs. 

3. Since Prototype takes place only in April and 
May, enter 1400 April and 1000 for May. 

4. Click OK, and OK again, to return to the schedule. 

Enter the costs for Testing... 

1. Right-click the word Testing, from the right click menu choose Edit 
ValueSet. The Select ValueSet to Edit dialog displays.  

2. Click the Edit button to the left of 2. Costs. 

3. Since Testing takes place only in March and April, there are no 
costs associated with other months. Therefore, 
enter 1500 for March and 2500 for April. 

4. Click OK, and OK again, to return to the sched-
ule.  You will see the values you entered in each 
task row however the graph will not appear yet. 

Choose F9 on the keyboard to refresh the 
Milestones schedule to show any values or 
words that are not fully visible. 
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Set up the DataGraphs that will display the ValueSets  

In the previous steps, you set up three ValueSets (Budget, Costs, and Manhours) and en-
tered the values for two of those ValueSets (Budget and Costs).  Next, you will set up two 
DataGraphs: The first will display Budget and Costs, and the second will display Manhours. 

DataGraph 1 

1. Select the Tools tab. 

2. In the Graph Options section choose Setup DataGraph.  The DataGraph Options dialog box displays with DatagGraph 1 
options showing. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3. Select the Assign ValueSets to this Graph... button the Assign ValueSet to DataGraph dialog box comes up.   

4. Check on 1. Budget.  Contains 4 Values and 2.Cost. Contains 5 Values . 

5. Click OK to go back to the DatagGraph 1 options.  

6. Check on Show this Graph. 

7. For Graph Height enter 2.00. 

8. For Data Display Format choose Points. Values entered for budget and costs will show on the DataGraph as the symbols 
selected under the respective ValueSets Graphic Properties tab.  

9. Under Y axis you can select values for High Number, Increment and Low Number these values build the Y-axis  values of 
the DataGraph.  For this tutorial we will leave the values at zero allowing Milestones to automatically build the Y axis val-
ues.  Do check on Include Horizontal Gridlines . For Line Style select 18.  For Line Color select Silver. 

10.Check on Extend Chart Gridlines into DataGaph Area. Monthly vertical grid-
lines that are showing in the schedule area will also  show in the DataGraph.  
(Keep this dialog box open for the next set of instructions). 

All selections below the DataGraphs tabs bor-
der are generic settings for all 3 DataGraphs. 

Milestones can have a total of 
three DataGraphs containing up 
to 8 ValueSets. 
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Set up the DataGraphs that will display the ValueSets cont’d 

DataGraph 2 

1. Select the DataGraph 2 tab. All options will be available for selection for DataGraph 2. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

2. Select the Assign ValueSets to this Graph... button.  The Assign ValueSet to DataGraph dialog box comes up.  

3. Check on 3. Manhours.  Contains 0 Values. 

4. Click OK to go back to the DatagGraph 2 options.  

5. Check on Show this Graph. 

6. For Graph Height enter 1.50. 

7. For Data Display Format choose Bars. Values entered for Manhours will show on the DataGraph as bars.  

8. Again leave the High Number, Increment and Low Number zero allowing Milestones to automatically build the Y axis 
values.  Do check on Include Horizontal Gridlines . For Line Style select 2.  For Line Color select Black. 

9. Under Background Color select light silver or a color of your choice. 

10.For Color Effects choose Fade 
to Bottom. 

11.Click OK to return to the sched-
ule. Budget and Cost DateGraph 
is generated.  Manhours Data-
Graph is generated however the 
values will not populate until 
the Manhours column is set up. 

Budget and Cost Points DataGraph 
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Enter values in the Values SmartColumn 

1. Click the (T) Text tool the toolbox. 

2. Click once in the Manhours column Research task row cell. 

3. Enter a value of 500.  

4. Select Enter or the down arrow key on your keyboard, to get to the next task row's Manhours cell. Notice, 
the DataGraph will build.   

5. Enter the following values: 
In Design cell enter 700 
In Prototype cell enter 200 
In Testing  cell enter 500 
When the last value is entered do not click enter or down arrow. Simply click with your mouse outside the 
schedule.  If you do select enter or the down arrow this will take you to a second page.  To get back to the 
first page choose the Edit tab. In the Delete section choose Current page. Below is the Manhours Data-
Graph populated with bars. 

Create a Values SmartColumn that contains user-entered values 

You will change the Manhours column to a Values SmartColumn, then enter values for that column. 

1. Click the () Arrow tool in the toolbox.  

2. Click the Manhours column heading.  The toolbar will change to the Selection tab with Current Object: Column Heading.   

3. Choose Switch to Column. 

4. In the Column Type and Format section, click the down arrow next to (none). 
From the drop down menu choose Values.  The Indicators for Values column dialog box displays. 

5. In the Indicators for Values column dialog box make no changes from the default options already chosen, just select OK 
to return to the schedule.  You will now see 0's in the Manhours Values SmartColumn. 

Manhours Values SmartColum and DataGraph  



12-1 

 

Open the schedule for this lesson. 

1. On the toolbar, choose File.  

2. In the Files and Templates: Open and Save Options section select 
Open Samples or Lessons.  The Open a Sample Chart dialog displays. 

3. Under Select a Folder below to Open, select Lessons.  The Lesson 
schedules will display in the window to the right. 

4. Pick Lesson 12 Starter Schedule.mlj.  

5. Save the schedule to an accessible folder on your computer. Choose 
the File tab.  In the Files and Templates: Open and Save Options sec-
tion, choose Save As….  In the menu that displays choose Chart.  
Name, then save the schedule. 

Numerical information can be shown along with a schedule. These numerical values are contained in ValueSets.  Up to 9 ValueSets can 
be added to a schedule.  These 9 ValueSets can be graphed on up to 3 DataGraphs, a maximum of 8 ValueSets per DataGraph.  ValueSets 
values are attached to symbols (e.g. each yellow symbol contains a Labor cost, each blue symbol contains a Material cost). The values on 
the symbols can also be totaled in a special ValueSet SmartColumn (e.g. Labor Costs column and Material Costs column). 

Type 4 ValueSet values are attached to symbols.  When the symbol moves, the values move with them. If the symbols move to a new 
time period then the DataGraph changes. If any values, attached to the symbols, increase or decrease, then the column values and Data-
Graph values also change.    

A Type 5 ValueSet can total up to 8 other ValueSets (e.g. Material cost ValueSet is added with Labor Cost ValueSet to get Total Cost Val-
ueSet which can be graphed). 

In this lesson you will learn how to: 

• Create two Type 4 Valuesets (Use Values from Symbols) 

• Create a Type 5 ValueSet (Total of other ValueSets)  

• Create 2 DataGraphs.  Overlay one to display 3 ValueSets 
on 1 DataGraph 

• Create ValueSet SmartColumns 

• Enter Material and Labor ValueSet values for symbols  

• Add a Substitutable text string to display entered Material 
and Labor values as symbol text 

Lesson 12 - More  
ValueSets and DataGraphs 

Lesson 12 Starter Schedule 
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Create a Materials and a Labor ValueSet as Type 4: Use Values from Symbols  
Material  ValueSet 
1. Click the Tools tab. 

2. In the Graph Options section, choose Set Up ValueSets.  The Create or Edit Val-
ueSets dialog box displays. 

3. Choose Weekly as the time period to align the values. 

4. Click the Create/Edit button to the left of 1: No Name Assigned.  The ValueSet 
Properties dialog box displays.    

5. For ValueSet Name enter Materials. 

6. Under the Data Source tab, choose Type 4: Use Values from Symbols as the Val-
ueSet type. 

7. Click the Graphic Properties tab to set the ValueSet Display Properties and Graph 
Properties. 

UNDER ValueSet Display Properties  

a. Check on List Numeric Values above or Below Graph to 
have numeric ValueSet values display in each time incre-
ment above the graph for Materials.    

b. Check on Graph Values to graph the Materials ValueSet 
values  in the DataGraph. 

c. Check on Graph as Cumulative to have Materials Val-
ueSet values add together to create the graph. 

d. Check on Values Represent Currency and the $ will dis-
play on all values for the Materials ValueSet in the Data-
Graph. 

e. Select 0 for Number of Decimals to Display.  Numbers 
will be shown as whole numbers. 

f. Check on Suppress Values of Zero to have zeros not be 
listed or graphed. 

g. Check on  Suppress Leading Values of Zero to have 
graph not start at zero and not list a starting zero. 

UNDER Graphic Properties  

a. Material ValueSet values are going to be graphed as 
points (symbols).  Under Symbol for Point Graphs: se-
lect 2 (a blue diamond).  The list of symbols available for 
points is a reflection of the toolbox. See tutorial Lesson 4 for more information on setting up symbols in the 
toolbox.  

b. For Size Override select 1.00.  Use this option to override the schedule’s default symbol size for just symbols in 
the DataGraph. 

8. Click OK to return to the Create or Edit ValueSets dialog box (keep 
this dialog box open for the next set of instructions.) 

The schedule’s default Symbol Size option is found on 
the Format tab in the Frame, Highlights section. 
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Create a Materials and a Labor ValueSet as Type 4: Use Values from Symbols (continued) 

Labor  ValueSet 
1. Click the Create/Edit button to the left of 2: No Name Assigned. The ValueSet 

Properties dialog box displays.    

2. For ValueSet Name enter Labor. 

3. Under the Data Source tab, choose Type 4: Use Values from Symbols as the Val-
ueSet type. 

4. Click the Graphic Properties tab to set the ValueSet Display Properties and 
Graph Properties. 

UNDER ValueSet Display Properties  

a. Check on List Numeric Values above or Below Graph 
to have numeric ValueSet values display in each time 
increment above the graph for Labor.    

b. Check on Graph Values to have Labor ValueSet values 
graph as bars, lines, or points in the DataGraph. 

c. Check on Graph as Cumulative to have Materials Val-
ueSet values add together to create the graph. 

d. Check on Values Represent Currency and the $ will 
display on all values for the Labor ValueSet in the 
DataGraph. 

e. Select 0 for Number of Decimals to Display.  All Values 
for the Labor ValueSet will not show any decimal val-
ues. 

f. Check on Suppress Values of Zero to have zeros not be 
listed or graphed. 

g. Check on  Suppress Leading Values of Zero to have graph not start at zero and not list a starting zero. 

UNDER Graphic Properties  

a. Labor ValueSet values are going to be graphed as points (symbols).  Under Symbol for Point Graphs: select 1 a yel-
low diamond.  The list of symbols available for points is based on the toolbox. See tutorial Lesson 4 for more infor-
mation on setting up symbols in the toolbox.  

b. For Size Override select 1.00.  Use this option to override the 
schedule’s default symbol size for symbols in the DataGraph. 

c. Under High/Low Graph Connection select Materials to have a 
line connect Labor and Materials points.  

d. Select a Lines Style of 9 (dashed line) for the line that connects the Labor and Materials points. 

e. Select Line/Bar Color of Medium blue to color the line between the Labor and Materials points. 

5. Click OK to return to the Create or Edit ValueSets dialog box (keep this dialog box open for the next set of instructions.) 

The schedule’s default Symbol Size option is found on 
the Format tab in the Frame, Highlights section. 
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Create Total Cost ValueSet as Type 5: Total of Other ValueSets 

1. Click the Create/Edit button to the left of 3: No Name Assigned  to reach the 
ValueSet Properties dialog box.   

2. For ValueSet Name enter Total Cost. 

3. Under the Data Source tab, choose Type 5: Total of other Values Sets as the ValueSet 
type.    

4. Click the Pick ValueSets to Sum button. The Se-
lect ValueSets to Sum dialog box displays. 

5.  In the Select ValueSets to Sum dialog box check 
on 1. Material and check on 2. Labor.   

6. Click OK. 
 
 
 
 
 
 
 
 
 
 

7. Click the Graphic Properties tab to Set the ValueSet Display 
Properties and Graph Properties. 
 

UNDER ValueSet Display Properties  

a. Check on Graph Values to have Labor ValueSet values 
graph as bars, lines, or points in the DataGraph. 

b. Check on Graph as Cumulative to have Materials Val-
ueSet values add together to create the graph. 

c. Check on Values Represent Currency and the $ will 
display on all values for the Labor ValueSet in the 
DataGraph 

d. Select 0 for Number of Decimals to Display.  All Values 
for the Labor ValueSet will not show any decimal val-
ues. 

e. Check on Suppress Values of Zero to have zeros not be 
listed or graphed. 

f. Check on  Suppress Leading Values of Zero to have 
graph not start at zero and not list a starting zero. 

g. Total Cost is going to be a line graph, check on Show 
Value Near Point (if shown as Line)  to have the Total 
Cost ValueSet values display at weekly time incre-
ments along the line that graphs. 

UNDER Graphic Properties  

a. Since Total Cost will be a line graph select Lines Style 
23  

b. For Line/Bar Color select orange for the color of the 
Total Cost line graph.  
 

8. Click OK to return to the Create or Edit ValueSets dialog box. You now have two Type 4 ValueSets and one Type 5 Val-
ueSet, none of which contains values. Choose OK to exit.  Nothing visible will be changed on the schedule. 
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Create 2 DataGraphs overlaying one to display 3 ValueSets on 1 DataGraph 

DataGraph 1 will contain the Total Cost ValueSet values graphed as a line while DataGraph 2 will overlay DataGraph 1 and 
will contain Labor and the Materials ValueSet values graphed as points. 

DataGraph 1 

 Select the Tools tab. 

 In the Graph Options section choose Setup DataGraph.  The DataGraph Options dialog box displays. 

3. Under the DataGraph 1 tab select  Assign ValueSets to this Graph button. The Assign ValueSet to DataGraph dialog dis-
plays. 

4. Check on 3. Total Cost, then click OK.  

5. Check on Show this Graph to have the DataGraph display on the schedule. 

6. Give a Graph Height of 3.00. Minimum height is .2  

7. Total Cost is to be a line graph therefore under Data Display Format choose Lines. 

8. For Background Color of the Graph choose light blue. 

9. Color Effect for the background choose Fade to Right. 

10. To combine two graphs of different Display Formats (in this tutorial, line for Total Cost and points for Labor and Materi-
als) check on Overlay ValueSets from DataGraph 2. 

11.Under Y-Axis you can select values for High Number, Increment and Low Number.  These values build the Y-axis  values 
of the DataGraph.  For High Number enter 14000.  For Increment enter 2000.  Leave Low Number at 0. 

12.Under Y-Axis check on Include Horizontal Gridlines. For Line Style select 2.  For Line Color select medium blue. 

13.Check on Plot Numbers Under Graph (instead of above) when Displayed because Materials and Labor ValueSets values 
were set to have the Weekly numeric values displayed. Now the values  will display below the DataGraph. 

14.Check on Extend Frame Shadow into DataGraph area because the starter schedule has a shadow. Keep this dialog open 
for the next part of this tutorial. 
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DataGraph 2 

1. Select DataGraph 2 tab.  

2. Under the DataGraph 2 tab select  Assign ValueSets to this Graph button. The Assign ValueSet to DataGraph dialog dis-
plays. 

3. Check on 1. Materials and 2. Labor, then click OK. 

4. Check on Show this Graph to have the DataGraph display on the schedule. 

5. Material and Labor values are to be points on the DataGraph  therefore under Data Display Format choose Points. 

6. Click OK to return to the schedule, the DataGraph will display without any values. Values will be added in the following 
pages. 

No formatting for the DataGraph 2 looks needs to be chosen because in DataGraph 1 the option Overlay ValueSets 
from DataGraph 2 was selected. Thus the information from ValueSets Material and Labor will be overlayed onto 
DataGraph 1.  Two DataGraphs are being used to distinguished the Data Display Format, for Total Costs the data will 
display as a line, as selected.  Material and Labor data will display as points, as selected.   

DataGraph Added to Schedule 
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Create ValueSet SmartColumns (total the symbol values by row) 

ValueSet SmartColumns sum specified ValueSets for each task row.  The columns currently on the schedule labeled Material 
and Labor cost need to be changed to ValueSet SmartColumns and assigned the corresponding Symbol ValueSet.  Then the 
symbol values that will be entered will total and populate for each task row in the assigned column.  Even though the All 
Projects task row has no symbol values entered,  as a summary level task it will populate with the totals of the lower level 
costs. 

1. Click the Material Costs column heading.  The toolbar will change to the Selection tab with Current Object: Column 
Heading.   On the left side of the toolbar select Switch to Column. 

2. In the Column Type and Format section click the down arrow in the field showing 
(none).  From the displayed menu choose ValueSet.  The ValueSet Options dialog box displays. 

3. For ValueSet to Use, choose 1. Materials select OK. 

4. On the toolbar in the  Column Type and Format section set the columns values Decimal Places to 0. 

5. Check on Currency  to show a $ sign next to each cell value in the column. 

6. Now do the same for the Labor Cost column. Select 2. Labor in the ValueSet Options dia-
log. 

No values will be in the columns yet. You will add the values in the next step. Note that the 
first column cells show $0, reflecting the selections for ValueSet and currency with no deci-
mal point. 

Schedule with ValueSet SmartColumns 
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Enter Material and Labor ValueSet values for symbols 

For each symbol, you can enter a value for Material ValueSet and/or Labor ValueSet. In this lesson, you will enter Labor cost 
values on the yellow symbols, and enter Material cost values on the blue symbols, in keeping with the color scheme of the 
columns and DataGraph. 

1. Click the ()  Arrow tool in the Toolbox. 

2. On the Project A task row select the first blue symbol, the toolbar changes to the Selection tab with Current Object: 
Symbol  

3. At the bottom of the toolbar choose the ValueSets tab. 

4. In the Material slot enter 300 as the value for this symbol, press the apply button.    

5. On the Project A task row select the next symbol which is yellow.  You will not have to reselect the ValueSets tab it will 
stay active. 

6. In the Labor slot enter 600 as the value for this symbol, press the apply button. 

7. Continue adding values using the matrix below. Enter Material cost values on the blue symbols. Enter Labor cost values 
on the yellow symbols. IMPORTANT, after entering a value choose the apply button. 

As each value is entered the DataGraph and the column values change. 

Project A  
Materials: 300, 400 
Labor: 500, 2000 
 

Project B 
Materials: 300, 600, 500 
Labor: 800, 1000 
 

Project C 
Materials: 500, 300, 500 
Labor: 500, 700, 300, 500 
 

Project D 
Materials: 300, 300, 200 
Labor: 600, 200 
 

Project E 
Materials: 200, 400, 200 
Labor: 500, 300, 600 
 

Schedule with DataGraph and ValueSet SmartColumns Populated 
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Add a Substitutable Text String to symbols to display entered Material and Labor values as symbol text. 

1. Click the ()  Arrow tool in the Toolbox. 

2. On the Project A task row right click the first blue symbol. 

3. On the menu that displays select, Select all 
Instances of this Symbol Type.  All blue sym-
bols will highlight with a box around them 
and the toolbar will change to the Selection 
tab Current Object: Symbols (15 Selected). 

4. At the bottom of the toolbar select the Text 
tab. 

5. In the Text section next to Line 1: enter &vs1. 
6. Then press the Apply Text Changes button. Now all 

blue symbols will have their Materials ValueSet value 
displayed as symbol text. 

 
 

7. On the Project A task row right click the first yellow symbol. 

8. On the menu that displays select, Select all Instances of this Symbol Type.  All yellow symbols will highlight with a box 
around them and the toolbar will change to the Selection tab Current Object: Symbols (14 Selected). 

9. At the bottom of the toolbar select the Text tab. 

10.In the Text section next to Line 1: enter &vs2. 

11.Then press the Apply Text Changes button. Now all yellow symbols will have their Labor ValueSet value displayed as 
symbol text. 

&vs1 is a substitutable text string that tells Milestones to 
add the values for the specified ValueSet (1-9) as symbol 
text.   The  background look of the symbol text is set for 
each symbol in the toolbox. Double click the symbol in the 
toolbox. Select the Text/Date Properties tab.  See the Text 
Background Box selections.  

Substitutable Text String  Adds ValueSet Values as Symbol Text 
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Open the schedule for this lesson 

1. On the toolbar, choose File.  

2. In the Files and Templates: Open and Save Options section 
select Open Samples or Lesson.  The Open a Sample Chart dia-
log displays. 

3. Under Select a Folder below to Open, select Lessons.  The Les-
son schedules will display in the window to the right. 

4. Pick Lesson 13 Starter Schedule.mlj.  

5. Save the schedule to an accessible folder on your computer. 
Choose the File tab.  In the Files and Templates: Open and 
Save Options section, choose Save As….  In the menu that dis-
plays choose Chart.  Name, then save the schedule. 

Create a percent complete SmartColumn with a percent complete pie 

Percent complete is used for showing and maintaining a project's progress. By default, this column will show progress based 
on the current date (here, the vertical dotted line).  To establish progress differently, a status symbol (here, the gold arrow 
symbol) can be used to manipulate the progress of project tasks. 

1. Using the () Arrow tool in the toolbox, click the % Comp. column heading.  The toolbar will change to the Selection tab 

with Current Object: Column Heading.  Choose Switch to Column. 

2. In the Column Type and Format section click the down arrow in the field showing 
(none).  Scroll and choose Percent Complete. The Percent Complete Settings dialog box displays. 

3. For Display Settings check on Include Percent Complete 
Symbol in column. 

4. Choose Symbol on Left. 

5. Click OK to return to the schedule.  The schedule will 
now have a % value and a % complete symbol for each 
task in the % Comp. column.    

In this lesson you will learn how to: 

• Create a percent complete SmartColumn with a percent 
complete pie. 

• Change the percent complete of a task. 

• Create two Values SmartColumns (columns which con-
tain values.) 

• Enter values in to the Values Smart Columns. 

• Create a Calculation/Indicator SmartColumn and set con-
ditions for symbols to appear. 

Lesson 13 - Calculation/Indicator 
and % Complete Columns 

Lesson 13 Starter Schedule 

The percent complete symbol is shape #97 in toolbox. For 
this schedule it is already set-up. If a percent symbol is 
not set-up the selected symbol in the dialog box will be-
come symbol shape #97. 

Percent Complete Column 

For the most accurate % complete, Allow Hourly Accuracy 
Date/Time settings and Allow Minute Accuracy Date/Time 
settings have already been selected in the Percent Com-
plete Settings Dialog  



13-2 

 

Change the percent complete of a task. 

1. Click  the () Arrow tool in the Toolbox. 

2. Go to the Roofing task, click on the status symbol (gold arrow), the toolbar is now active for 
that symbol. Use the calendar icon, changing the date to 2/15/2021.   Then the Time to 00.00. 
Notice the change in the bar shading, % Comp. column value is now 31% and the percent com-
plete symbol has changed . 

3. Click the (T) Text tool in the toolbox. 

4. Move the cursor to Roofing task, in the Percent Complete cell back space through the 31 % complete text . 

5. Enter 75 (for 75%).  Then press Enter on the keyboard.  Notice that the status symbol moved to match the new percent. 
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Create Two Values SmartColumns  

The Cost and Budget columns will be changed to Values SmartColumns.   

1. Click the () Arrow tool in the toolbox.  

2. Click the Cost column heading.  The toolbar will change to the Selection tab with Current Object: Column Heading. 
Choose Switch to Column. 

3. In the Column Type and Format section click the down arrow in the field showing 
(none).  Scroll and choose Values.  The Indicators for Values Column dialog box displays. 

4. Click OK because you only want to display the values that will be entered.. 

5. Also on the toolbar, in the Column Type and Format section under Decimal Places: Select 0 and check on Currency. 

Now, do the same for the Budget column. 

1. Click the Budget column heading. The toolbar will change to the Selection tab Current Object: Column Heading.  Choose 
Switch to Column. 

2. In the Column Type and Format section click the down arrow in the field showing 
(none). Scroll and choose Values.  The Indicators for Values Column dialog box appears. 

3. Click OK because you only want to display the values that will be entered. 

4. On the toolbar, in the Column Type and Format section under Decimal Places: Select 0 and check on Currency. 

Enter values into the Values SmartColumns  

1. Click the (T) Text tool in the toolbox. 

2. Click once in the cell of the Cost column for the Foundation task row and  enter 500. 

3. Click Enter or the down arrow key on the keyboard, to get to the next task row's Cost cell and enter the following values 
for all tasks. Framing/Siding 400, Roofing 600, Insulation 800, Brick 700, Drywall 500, Texture/Paint 450, Carpeting/
Flooring 385, Interior/Misc. 485, Punch List 950, Complete 625 (Do not press enter or the down arrow key simply click 
out of the schedule. This prevents adding a second page) 

4. Continue entering the following values for Budget. Foundation 200, Framing/Siding 800, Roofing 500, Insulation 800, 
Brick 700, Drywall 400, Texture/Paint 600, Carpeting/Flooring 400, Interior/Misc. 600, Punch List 1200, Complete 800 (Do 
not press enter or the down arrow key simply click out of the schedule. This prevents adding a second page) 

Cost and Budget values for the BHSubdiv, Lot 50 task row are automatically totaled because the schedule is outlined.  This setting is 
under Layout menu.  In the Other section (choose Summary Bar Settings…). 

Values Columns 
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Create a Calculation/Indicator SmartColumn and set conditions for symbols to appear 

Now, define the Budget-(minus) Cost column as a Calculation/Indicator SmartColumn which subtracts the Cost column 
values from the Budget column values.  Then display symbols based on those values. 

1. Use the () Arrow tool in the toolbox,  

2. Click the Budget - Cost column heading.  The toolbar will change to Current Object :Column Heading.  Choose Switch to 
Column. 

3. In the Column Type and Format section under Decimal Places: Select 0 and check on Currency. 

4. In the Column Type and Format section click the down arrow in the field showing 
(none).  Scroll and choose Calculation/Indicator.  The Calculation Settings dialog box displays. 

5. On the Calculation tab choose Calculation of Two Columns. 

6. Under Calculation of Two Columns  in the first box click the down arrow 
scroll and choose: 12: Budget. 

7. In the second box click the down arrow, scroll and choose the (-) minus sign . 

8. In the third box click the down arrow, scroll and choose: 11: Cost.  

9. Click the Graphical Indicators tab to set up indicators and 
values to display in the column 

10.For Column to Compare, choose 13: Budget - Cost. 

11.Choose Pick indicator symbols based upon the following 
conditions. 

12.Choose Pre-Selects (the value parameters and stoplights are 
already set-up). Click the down arrow to see the preset para-
ments: Red symbol Cost > Budget; a green symbol Budget > 
Cost; and a yellow symbol when the Budget = Cost.   

13.For Symbol size choose 1.50. 

14.Choose Align Symbol on Left. 

15.Check on Display numerical value also. 

16.Press OK  to see the completed schedule. 

Schedule With Calculation Indicator Column 
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Open the Schedule for this Lesson. 

1. On the toolbar, choose File.  

2. In the Files and Templates: Open and Save Options section se-
lect Open Samples or Lessons.  The Open a Sample Chart dialog 
displays. 

3. Under Select a Folder below to Open, select Lessons.  The Les-
son schedules will display in the window to the right. 

4. Pick Lesson 14 Starter Schedule.mlj.  

5. Save the schedule to an accessible folder on your computer. 
Choose the File tab.  In the Files and Templates: Open and Save 
Options section, choose Save As….  In the menu that displays 
choose Chart.  Name, then save the schedule. 

In this lesson you will learn how to: 

• Create a Values SmartColumn with Indicators  

• Set-up the Indicators  for Values SmartColumn  

• Enter Sales Values for  Values SmartColumn to Display 
Indicators 

Lesson 14 - Values SmartColumns 

A Values SmartColumn can contain numbers and/or indicator symbols based on the numbers from the same column or another column 
with values.  

In this lesson the Values will be entered in to a the Sales $/Indicator SmartColumn and indicators will display in the column based on the 
sales dollar amount. 

Indicators can be symbols, a colored cell and/or text. 

Lesson 14 Starter Schedule 
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Create a Values SmartColumn with Indicators  

You will make the Sales$/Indicator column a Values SmartColumn 

1. Using the () Arrow tool in the toolbox, click the Sales$/Indicator column heading. The toolbar will change to the Selec-
tion tab with Current Object: Column Heading.   

2. Choose Switch to Column. The toolbar will change to the Selection tab with Current Object: Column 11.   

3. In the Column Type and Format section under Decimal Places: 
choose 0. 

4. In the Column Type and Format section under Decimal Places: 
check on Currency. 

5. In the Column Type and Format section click the down arrow in the 
field showing (none). Scroll and choose Values.  The Indicators for 
Values Column dialog box displays. 

Set-Up Indicators for Values SmartColumn  

Symbol indicators 

You will assign indicator symbols to sales figures for sales <$30,000, =or> $30,000 < $75,000 and =or> $75,000 < $100,000 

Indicator for sales <$30,000 

1. Under Pick indicator symbology based upon the following conditions: click the down arrow to see 20 Active/Ignored 
symbols and their conditions.  

2. Click on 1 | Ignore 0.00 < Value <=0.00 in the list.  The Indicator 
Condition Settings dialog displays.  

3. Click on the Indicator Symbol down arrow. From the drop down 
list of symbols choose the red checkmark. 

4. Choose Conditions based upon the value in a cell. 

5. Enter 0 and 29999.99. 

6. Choose OK to return to the Indicators for Values Column dialog 
box (keep this dialog box open for the next set of instructions). 

 

6. For Column to Compare note that 11: Sales$/Indicator is 
selected.  This works for this tutorial as we want the indi-
cators to display in this column when the sales figures 
are added to this column. 

7. Choose Pick indicator symbology based upon the follow-
ing conditions. We will set up the indicators in the next 
section of the tutorial. 

8. Set the Symbol size to 2.30. 

A Values SmartColumn can contain numbers and/or indicator 
symbols based on the numbers from the same column or an-
other column with values.  

9. Choose Align Symbol on right. 

10.Check on Display numerical value also to have the column display the added numerical value along with the indicator 
(keep this dialog box open for the next set of instructions). 
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Set-Up Indicators for Values SmartColumn Cont’d 

Symbol indicators cont’d 

Indicator for sales =or> $30,000 < $75,000  

1. Under Pick indicator symbology based upon the following conditions: click the down arrow to see 20 Active/Ignored 
symbols and their conditions.  

2. Click on 2 | Ignore 0.00 < Value <=0.00 in the list.  The Indi-
cator Condition Settings dialog displays.  

3. Click on the Indicator Symbol down arrow, from the drop 
down list of symbols choose the silver diamond. 

4. Choose Conditions based upon the value in a cell. 

5. Enter 29999.99. and 74999.99. 

6. Choose OK to return to the Indicators for Values Column 
dialog box (keep this dialog box open for the next set of in-
structions). 

Indicator for sales =or> $75,000 < $100,000 

1. Under Pick indicator symbology based upon the following conditions: click the down arrow to see 20 Active/Ignored 
symbols and their conditions.  

2. Click on 3 | Ignore 0.00 < Value <=0.00 in the list.  The Indi-
cator Condition Settings dialog displays.  

3. Click on the Indicator Symbol down arrow, from the drop 
down list of symbols choose the gold star. 

4. Choose Conditions based upon the value in a cell. 

5. Enter 74999.99. and 99999.99. 

6. Choose OK to return to the Indicators for Values Column 
dialog box (keep this dialog box open for the next set of 
instructions). 
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Set-Up Indicators for Values SmartColumn Cont’d 

Text and colored cell indicators  

Indicators for sales =or> $100,000  

1. Under Pick indicator symbology based upon the following conditions: click the down arrow to see 20 Active/Ignored 
symbols and their conditions.  

2. Click on 4 | Ignore 0.00 < Value <=0.00 in the list.  
The Indicator Condition Settings dialog displays.  

3. Next to Indicator Symbol check on Fill Cell with 
symbol color instead of drawing symbol. 

4. For Indicator Text select the space bar 7 times then 
enter ACE. 

5. For Symbol Color select Yellow. 

6. Choose Conditions based upon the value in a cell. 

7. Enter 99999.99 and 9999999.99. 

8. Choose OK to return to the Indicators for Values 
Column dialog box.  

9. Click OK again to return to the schedule. Nothing will have changed. You will enter the sales values in the next step, 
which will then display the set-up indicators in the column. 

Entered text defaults to the cell’s center.  For this indi-
cator text needs to be to the right of the cell, thus 
using the space bar to position the text. 

Enter Sales Values in the Values SmartColumn to Display Indicators 

1. Click the (T) Text tool in the toolbox. 

2. Click once in the first cell of the Sales$/Indicator column for Herman. 

3. Enter 100000. 

4. Press Enter. The cell will populate with the value as currency and the indicator for =or> $100,000 will display. 

5. Continue by entering  the following values for each cell  
Baker 75000, Sanchez 30000, Roberts 29000, Johnson 150000, Landin 74000 after entering this value do not press enter 
just click out of the cell. This prevents creating a new page. 

6. Upon completion of entering all values the schedule will look like the schedule on the first page of the tutorial. 
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Open and save the schedule for this lesson 

1. On the toolbar, choose File.  

2. In the Files and Templates: Open and Save Options section select Open 
Samples or Lessons.  The Open a Sample Chart dialog displays. 

3. Under Select a Folder below to Open, select Lessons.  The Lesson 
schedules will display in the window to the right. 

4. Pick Lesson 15 Starter Schedule.mlj.  

5. Save the schedule to an accessible folder on your computer. Choose the 
File tab.  In the Files and Templates: Open and Save Options section, 
choose Save As….  In the menu that displays choose Chart.  Name, then 
save the schedule. 

Fill the cell with color instead of stoplights 

1. Using the () Arrow tool in the toolbox, click the Stoplight column heading. 
The toolbar will change to the Selection tab with Current Object: Column 
Heading. Choose Switch to Column. 

2. In the Column Type and Format section click the Properties 
button.  The Stoplight Options dialog box displays. 

3. Leave Standard Stoplight selected.  Check on Fill the cell with color instead of 
displaying a symbol.       

4. Click OK.  The cells that once showed stoplights now show cells filled with the 
stoplight color. 

Lesson 15 Starter Schedule 

Create a column with standard stoplights 

1. Using the () Arrow tool in the toolbox, click the Stoplight column heading. The toolbar will change to the 
Selection tab with Current Object: Column Heading. Choose Switch to Column. 

2. In the Column Type and Format section click the down arrow in the 
field showing (none).  Scroll and choose Stoplight.  The Stoplight Options dialog box displays. 

3. Choose Standard Stoplight.  

4. Click OK.  There will be no change in the schedule. 

5. Click the (T) Text tool in the toolbox.  Move the cursor to first cell 
under the word Stoplight click, then type 1. 

6. Click the keyboard’s down arrow to move to the second cell, the 1 
in the first cell is now a green stoplight. Type 2.  

7. Click the keyboard’s down arrow to move to the third cell, the 2 in 
the second cell is now a yellow stoplight. Type 3.    

8. Click the keyboard’s down arrow to move to the fourth cell, the 3 in 
the third cell is now a yellow stoplight. Type 4. After entering 4 do not choose enter, click out of the cell. This prevents 
creating a new page and the 4 fourth cell is now a blue stoplight. 

In this lesson you will learn how to: 

• Create a column with standard stoplights. 

• Fill cells with color.   

• Set up custom stoplights. 

Lesson 15 - Stoplight Columns 
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Set up custom stoplights 

1. Using the () Arrow tool in the toolbox, click the Stoplight column 
heading. The toolbar will change to the Selection tab with Current 
Object: Column Heading. Choose Switch to Column. 

2. In the Column Type and Format section click the Proper-
ties button.  The Stoplight Options dialog box displays. 

3. Uncheck Fill the Cell with color instead of displaying a symbol. 

4. Change Stoplight symbol size to 4.0. 

5. Under Custom Stoplight choose Custom Pick your own numbers, 
symbols, colors, and text. 

6. For Number click the down arrow choose 10. 

7. For Symbol click the down arrow choose the red star. 

8. For Text type in Finish.    

9. For Number click the down arrow choose 9. 

10.For Symbol click the down arrow choose the blue arrow pointing 
left. 

11.For Text type in Behind.    

12.For Number click the down arrow choose 8. 

13.For Symbol click the down arrow scroll and choose the red oval. 

14.For Color pick Lime.  

15.For Text type in Ahead. 

16.Click OK.  The stoplight column will appear empty, however it still has the numbers 1-4 in the cells. 

17.Right click the Stoplight column heading and choose Clear Column Text. 

18.Click the (T) Text tool in the toolbox.  
Move the cursor to first cell under the 
word Stoplight click, then type 10. 

19.Click the keyboard’s down arrow to 
move to the second cell.  The 10 in the 
first cell is now a red star with Finish. 
Type 8.  

20.Click the keyboard’s down arrow to 
move to the third cell.  The 8 in the 
second cell is now  a lime oval with 
Ahead. Type 9.    

21.Click the keyboard’s down arrow to 
move to the fourth cell.  The 9 in the 
third cell is now a blue arrow pointing 
left with Behind. Type 9. After enter-
ing 9 do not click enter. Click out of 
the cell. This prevents creating a new 
page and the 9 in the fourth cell is 
now a blue arrow pointing left with 
Behind. 

 

Schedule with Custom Stoplights 
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Lesson 16 - Microsoft Project to Milestones 
Wizard-Microsoft Project Installed 

In this lesson you will learn how to: 

• Import Microsoft Project MPP files into Milestones 
Professional using the import wizard. 

• Customize the imported schedule. 

• Save as a Custom Project Template. 

• Import Microsoft Project MPP files using the new Cus-
tom Project Template. 

• Change the Microsoft Project MPP file and update 
(“refresh”) the Milestones Professional schedule. 

Import a Microsoft Project MPP  

1. In Milestones Professional, choose the Connections tab. 

2. In the Microsoft Project section choose Create Report from Project.  

3. To select the file to import, navigate to Program Files\KIDASA\Milestones Profes-
sional 2020\Samples\Lessons folder.  Select MS Project File.mpp.  Choose Open 
The Microsoft Project to Milestones Wizard will display. 

Microsoft Project to Milestones Wizard  

The Microsoft Project to Milestones Wizard has four import options. Try a built-in template: Select from predesigned templates 
that import specific date fields and column information from Microsoft Project into a Milestones schedule. Let the wizard guide 
you: Step by step selection of how you want your Microsoft Project information imported into a Milestones schedule. Make a 
swimlane chart: Import multiple Microsoft Project tasks into a swimlane by coding fields in Microsoft Project to have specific date 
symbology and symbol and horizontal bar styles populate the Milestones schedule.  Use your own custom template: Starting with 
a schedule imported using the wizard modify it to your liking then save it to use the next time you import.  
 

1. For ID Field (required) , choose Uniqueid. 

2. Leave Nickname (optional) blank. 

3. For Outline level ( optional ) choose 20.  

4.  Import Flag (optional) choose all tasks. 

5. Choose Try a built-in template. The Project to Milestones Wizard - Pick a built-in template dialog displays. 

Important the Project to Milestones Wizard template options will be different based on whether Microsoft  Project is installed or not installed 
on your computer. 

If your files are in Project Server or Project Online first open it, then choose Create Report 
from Project Server. For this tutorial the Microsoft Project file to be imported is on your 

desk top so choose Create Report from Project. 

There are several options to limit the Microsoft Project information importing into a Milestones schedule. In Microsoft Project, filter the sched-
ule save it then select it for importing. In the wizard limit the tasks by Outline Level or select a Flag field that has been set-up in Microsoft Pro-
ject with yes applied to all tasks to be imported.  

Once a schedule is built it can be refreshed. In order for Mile-
stones to connect to tasks in Microsoft Project it needs sym-
bols and cells to be tagged with unique identifiers.  Best prac-
tice is to use the Microsoft Project Unique ID field for the 
unique identifier.   

For More information choose the question mark Icon.  

Nickname (optional) - If you are going to combine 2 or more 
Milestones imported schedules that were generated from 
different Microsoft Project files use the nickname field. Give a 
nickname to each Microsoft Project file, enter it in the nick-
name field during import it will be applied to each symbol and 
cell along with the Unique ID. 

For More information choose the         question mark Icon.  
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Project to Milestones Wizard - Pick a built–in template dialog  

The Project to Milestones Wizard, Built in template option 
has 10 categories to choose from and each Category has a 
variety of chart Types.  As the category and type are select-
ed the wizard displays a picture of the selection. 

Make the following selections: 

1. Choose Gantt. 

2. Choose Basic Gantt. 

3. Choose Next.  The Project to Milestones Wizard - Pick 
symbology options dialog displays. 

 

 

 

 

 

Project to Milestones Wizard - Pick symbology options dialog  

1. For Summary Bars choose Project.   

2. Check on Shade % complete - Symbols and horizontal bars 
color based on the percent complete of the task. 

3. Check on Show Dependencies  - Dependent symbols ( suc-
cessors) will be linked with vertical links. 

4. Choose Next.  The Project to Milestones Wizard - Add a 
title dialog displays. 

Project to Milestones Wizard -  Add a Title dialog 

1. Select Enter a new title. 

2. In the first blank section, this will be line 1 of the schedule’s 
title, type in Alpha & Beta Projects. 

3. In the second blank section, this will be line 2 of the sched-
ule’s title, type in Review Schedule. 

4. Choose Next. The Project to Milestones Wizard - Add sym-
bol text and notes dialog displays. 

 

 

 

Summary information will be drawn from Microsoft Project 
information and symbols and bars are independent of lower 
level information.  If Milestones is selected the summary bars 
displayed are reflections of the lower level tasks and can only  
be changed by moving the lower level tasks.  

Set % for individual bars should be selected when multiple 
tasks are placed on a single Milestones task row. For instance 
you are going to import the schedule then move tasks from 
their individual rows to a shared task row. 
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The Project to Milestones Wizard - Add symbol text and notes dialog 

1. Under Finish symbol text - Line 1: choose from the drop 
down list  Resource Names. If a resource name is associ-
ated with a task in Microsoft Project that name will popu-
late as symbol text for the finish symbol. The placement 
of the text to the symbol is based on the parameters set 
for that symbol in the Milestones schedule’s toolbox. 

2. Under Start symbol note choose from the drop down list  
% Complete. The % complete for the Microsoft Project  
task will populate as a symbol note for the start symbol.  

3. Symbol notes can be hidden or shown. Check on Show 
notes on schedule, to have the note display near the 
start symbol.  Once the schedule is imported, the note 
can be dragged anywhere on the schedule and is still 
attached to its symbol. 

4. Choose Next.  The Project to Milestones Wizard - Set 
schedule size and rows dialog displays. 

 
The Project to Milestones Wizard - Set schedule size and rows dialog 

1. For Rows per page choose 9. 

2. Check on Show the Legend. 

3. Choose Next. The Project to Milestones Wizard -  Apply  
a color theme dialog displays. 

 

 

 

 

 

 

 

 

 

The Project to Milestones Wizard - Apply a color theme dialog 

1. Under Apply a color theme choose Autumn. 

2. Choose Use Outline Shading. 

3. Check on Include toolbox colors. 

4. Choose Finish. 

Milestones will now generate the schedule found on the 
following page.  
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Generated Milestones Professional Schedule 

Customize the imported schedule 

Change the Title 

1. Click the title.  The toolbar at the top of the Mile-
stones window is now active for the title.  

2. Change the text color in Line 1 and Line 2 to black. 

3. Uncheck Insert extra space under title. 
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Customize the imported schedule cont’d 

Add Cost column getting the information from the Microsoft Project file  

1. If the MS Project File.mpp is not still opened open it. Program Files\KIDASA\Milestones Professional 2020\Samples\Lessons 
folder.  Select MS Project File.mpp.   

2. Go back to the Milestones schedule and save it. Choose the File tab choose Save As choose Chart. 

3. Click the Connections tab in the Other section check on Populate Column from Project when column tag added. 

4. Click on Percent Complete column heading (it will highlight). This action is to place the column to be added to the right of the 
Percent Complete column. 

5. Choose the Insert tab. 

6. In the Rows, Columns section choose New Column, a drop down menu displays choose Microsoft Project Column. 

7. The Column Properties dialog box displays with a drop down menu activated, choose Cost. 

8. Choose OK. 

9. The Populate this column dialog box displays verifying the Field name: (Cost in this instance) that will populate the column, as 
well as a selection menu for the Unique ID field to be used to tag each cell in the column. By default the field used in the original 
import will show (UniqueID in this instance). 

10.Choose Finish.  The column will be inserted, and will be populated with the Microsoft Project cost information.  It will also be 
tagged for future Refresh if the Microsoft Project information changes. 

11.You may need to expand the column.  Move the cursor to the left edge of the column, when you get the     column width 
change cursor drag the column to the left. 

12. Keep the Milestones file open to continue with the next portion of this tutorial. 

 

 

Customized Schedule with Changed Title and Imported Cost Column 
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Save as a Custom Project Template. 

Now that you have your schedule looking exactly how you want, it can be saved as a Custom Project Template.  Saving the sched-
ule as Custom Project Template adds the schedule into the Project to Milestones Wizard.  Once saved, next time you use the Pro-
ject to Milestones Wizard it will be available in the Use your own custom template option for import of another Microsoft Project 
file. 

1. Choose the Connections tab.  

2. In the Microsoft Project section choose Save Custom Project Template. 

3. The Microsoft Project Custom Import Template Description dialog box displays. Enter a description for your template like “My 
template with start, end, baseline start end bars and cost column.” 

4. Choose OK. 

5. The Save Chart File dialog box displays.  

6. Give your template a name CustomTemplateAlpha&Beta. 

7. Choose Save. 

8. Close the schedule. 

 

Import Microsoft Project MPP files using the Use Your Own Custom Template Option 

Now you will import the MS Project file.mpp into the Custom Project Template, CustomTemplateAlpha&Beta you just created. 

1. In Milestones Professional, choose the Connections tab. 

2. In the Microsoft Office Project section choose Create Report from Project. The Select the schedule to open dialog box displays. 

3. Navigate to the Program Files\KIDASA\Milestones Professional 2019\Samples\Lesson folder. 

4. Select the MS Project File.mpp file.  The Project to Milestones Wizard will display. 

Project to Milestones Wizard 

1. For ID Field (required) , choose Uniqueid. 

2. Leave Nickname (optional) blank. 

3. For Outline level ( optional ) choose 20. For Tag . 

4. Import Flag (optional) choose All Tasks. 

5. Choose Use your own custom template. The Project to 

Milestones Wizard - Custom template options dialog 

displays. 

 

 

 

 

 

 

 

 

Important:  
Save all Custom Project Templates to a folder that you will not delete or move.  This should not be the same folder where you save your 
working Milestones Professional files. 
 
If an initial import file has more than one page and you want to use it as a Custom Project Template delete all but one page of the schedule 
before saving it as a Custom Project Templates . 
 
If you save a Custom Project Template and no longer want to see it in the wizard Use the Manage Custom Project Templates option found 
on the Connections tab in the Microsoft Project section. 
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The Project to Milestones Wizard - Custom template options dialog 

1. At the top of the dialog click the down arrow to select the 
saved custom template, CustomTemplateAl-
pha&Beta.mlj. Note that the Wizard displays a picture of 
the CustomTemplateAlpha&Beta.mlj. 

2. Under Finish Symbol Text, next to 1: Click the down arrow 
then select Duration.  

3. Choose Project summary bars. 

4. Check on Color Critical Tasks Red. 

5. Choose Finish. Choose Finish. The generated file (see be-
low) will look like the saved Custom Project Template, 
CustomTemplateAlpha&Beta.mlj, with the exception of the new options selected; critical task colored red and the task duration 
as symbol text on the finish symbols. 

6. Save this file to a different location than were you saved the Custom Project Template.  Choose Save As. Choose Chart.  Call the 
schedule Alpha & Beta Projects.  You will use this schedule later in the tutorial, keep it opened. 

Even if your template has symbol and note text from the 
initial import, you still must select the symbol or note text in 
this dialog to have text display on the generated schedule. 

Select this option to have all Microsoft Project tasks marked 
as critical color red in the generated Milestone file. 

Generated Milestones Professional Schedule 
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Refresh an imported Milestones Professional schedule when the Microsoft Project file has been changed  

Change the Microsoft Project file 
1. Bring up the Microsoft Project file MS Project.mpp.  If you closed it navigate to the Program Files\KIDASA\Milestones Profes-

sional 2019\Samples\Lessons folder to open it. If you do not want to make the changes yourself you can skip this section and 
find a changed file in Program Files\KIDASA\Milestones Professional 2019\Samples\Lessons folder called MS Project File 
Changed.mpp. 

2. Make the following change to: Program Files\KIDASA\Milestones Professional 2019\Samples\Lessons folder 

Project Beta tasks: 
a. Design Finish Date changed from 6/02/22 to 7/02/22. Because of this change the following other items changed 

• Design % Complete changed from 50% to 36%. 

• Design Duration changed from 54 days to 76 days. 

• Design Cost changed from $308,660 to $312,180. 

b. Test Finish Date changed from 8/05/22 to 9/05/22. Because of this change the following other items changed 

• Design % Complete changed from 35% to 22%. 

• Design Duration changed from 36 days to 57 days. 

• Design Cost changed from $305,780 to $309,140. 

Because of the above a and b changes the following items in Project Beta summary changed  

• Project Beta  % Complete changed from 37% to 28%. 

• Project Beta Cost changed from $722,460 to $729,340. 

3. Choose Save as and save this file to your desktop as MS Project File Changed.mpp. 

Refresh the Milestones Professional schedule to reflect the changes made to the Microsoft Project file  

1. Go back to Milestones Professional Alpha & Beta Projects.mlj schedule should still be opened. If not open it. 

2. Choose the Connections tab. 

3. In the Microsoft Project section choose Refresh Previously imported Project. 

4. From the drop down choose Refresh from MPP/MPD File…  the Select 
Schedule to Open dialog box displays. 

5. Select MS Project File Changed.mpp saved to your desktop or  Program Files\KIDASA\Milestones Professional 2019
\Samples\Lessons folder called MS Project File Changed.mpp. 

6. Choose Open. The Refresh Microsoft Project dialog displays. 

The Refresh Microsoft Project dialog  

1. For REFRESH USING : select UniqueID. You should always select the unique 
identifier used in the original import. 

2. Under SYMBOL TEXT check on Refresh Symbol Text. 

3. Under SYMBOL TEXT choose: Update only symbols with symbol text tags.  
This is necessary as duration values in the Microsoft Project file changed, 
thus the duration values as symbol text on the Milestones schedule need to 
be updated. 

4. Under PERCENT COMPLETE: Check on Refresh percent complete.  

5. Under Percent Complete for the % complete field choose % Complete. This 
is necessary to have fill to status of the symbols and horizontal bars update. 

6. Under OPTIONS check on Refresh tagged columns. To have the information 
in the Milestones Cost and Percent Complete columns update based on the 
changes in the Microsoft Project file. 

7. Under OPTIONS check on Ignore times (compare dates only).  

8. Under OPTIONS Check on Highlight Changed Dates. Milestones will highlight any changed dates in orange. 

9. Choose REFRESH. The schedule will be generated and a Refresh report will also be generated.  See the next page to view the 
Refreshed Milestones schedule and Refresh Report. 
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Refreshed Schedule with the Updated   
Symbol Dates  

 Percent Complete and Cost Columns  
Duration Symbol Text 

The generated schedule shows the finish dates that were changed highlighted in orange by Milestones Refresh option.   
Note: We have highlighted in green the changes in the symbol text duration values and the Percent Complete and Cost column val-
ue changes. 

The Refresh Report shows: 
1. The change to what symbol, the old and new date, symbol or note text 

change. 

2. The % change for the tasks.   

3. The Refresh Report  can be printed. 

To turn off orange highlighting choose the Connections tab in the Other section uncheck Refresh Highlighting. 

Highlighting does not save when the file is saved. 
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Open the schedule for this lesson 

1. On the toolbar, choose File.  

2. In the Files and Templates: Open and Save Options section 
select Open Samples or Lessons.  The Open a Sample Chart 
dialog displays. 

3. Under Select a Folder below to Open, go to the bottom of 
the list select Lessons. The Lesson schedules will display in 
the window to the right. 

4. Pick Lesson 17 Starter Schedule.mlj.  

5. Save the schedule to an accessible folder on your computer. 
Choose the File tab.  In the Files and Templates: Open and 
Save Options section, choose Save As….  In the menu that 
displays choose Chart.  Name, then save the schedule. 

In this lesson you will learn how to: 

• Set up the baseline symbols, horizontal bars, and op-
tions using the Baseline Setup Wizard 

• Insert a baseline 

• Insert baseline start and end date columns 

• Insert the baseline duration column 

• Add a baseline to a blank schedule 

• Add Symbol Automation Tag columns to show base-
line start and end slip dates 

• Add slips 
Lesson 17 - Work with a Baseline 

Set up the baseline symbols and horizontal bars using the Baseline Setup Wizard 

The Baseline Setup Wizard guides you through setting up the symbology (symbols and bars) to be used for the task baseline 
display and for the summary bar baseline display.  
Set-up Baseline start symbol, Baseline horizontal bar, Baseline end symbol 

1. Choose the View tab.  

2. In the Baseline section choose Baseline Setup.  The Baseline Setup Wizard - Select Task Bar Symbols will display. 

3. For Baseline Start Date choose the first red 
diamond from the list. 

4. For Baseline Horizontal Bar choose the bar 
with red diagonal lines from the list. 

5. For Baseline End Date symbol choose the 
second red diamond from the list.  This will be 
the symbol used to show the baseline finish 
dates. 

6. Select Next. The Baseline Setup Wizard - Se-
lect Summary Bar Symbols window will dis-
play. Leave open and go to next page of this 
tutorial. 

Any number of symbols in the Milestones Professional toolbox can be set to be “baseline” symbols.  These baseline symbols are treated 
differently than “normal” or “comment” symbols.  In this lesson you will learn some of the special characteristics of baseline symbols. 
Since you can designate as many symbols as  needed as baseline symbols it’s possible to show multiple baselines with unique symbology.    

Lesson 17 Starter Schedule 

The selections for the symbols and horizontal 
bars are reflections of the symbols and bars in 
the schedule’s toolbox 
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Set up the baseline using the Baseline Setup Wizard cont’d 

Set-up Summary Baseline start symbol, Summary Baseline horizontal bar, Summary Baseline end symbol 

In the Baseline Setup Wizard - Select Summary Bar Symbols window select the following: 

1. For Summary Baseline Start choose the first 
black vertical line symbol in the list. 

2. For Summary Baseline Horizontal Bar choose 
the first solid red bar in the list.   

3. For Summary Baseline End choose the second 
black vertical line symbol in the list.   

4. Select Next. The Baseline Setup Wizard - Se-
lect Summary Bar Symbols window will dis-
play. Leave open and go to next set of instruc-
tions . 
 

 

 
Choose Baseline options  

In the Baseline Setup Wizard - Set Lock, Hide and Highlight Baseline window select the following: 

1. Check on Lock Baseline Symbols and Bars.  This 
prevents movement of the baseline on the 
Milestones schedule 

2. Uncheck Hide Baseline Symbols and Bars. All 
Baseline will be contained in the schedule how-
ever if checked on all baseline will be hidden, if 
unchecked on all baseline will be shown. 

3. Check on Highlight Baseline Symbols and Bars. 
If checked on baseline will be highlighted in 
yellow. 

4. Uncheck Hide Baseline Summary bars.  All 
Baseline will be contained in the schedule how-
ever if checked on baseline summary will not 
show and lower level baseline will show. 

5. Uncheck Moving a Baseline Symbol affects non-Baseline symbols.  Movement of a baseline symbol can affect all subse-
quent symbols on a task row or connected symbols. When this option is selected and Dependency Mode is turned on. 
You will be prompted to accept the movement of the other symbols.  

6. Select Apply.  

7. Select Finish. You will not see any change to the schedule yet.   

More about Baseline Symbols 
Once a symbol has been set as a baseline symbol in the wizard it remains a baseline symbol on the 
schedule.  To return the symbol to a normal symbol  double click the symbol in the toolbox.  This 
displays the Symbol Options dialog box.  Here, change its property back to Normal Symbol. 
 
Several symbols can be set to be baseline symbols so that multiple baselines can be shown.  To set-
up multiple baseline symbols double click any symbol in the toolbox and change its property to 
Baseline Symbol.  Continue this process until you have the number of baseline symbols necessary 
for your schedule. 
 
If the Lock Baseline feature is checked on the Baseline Symbol option in the toolbox will be greyed 
out. To unlock baseline choose the View tab in the Baseline section uncheck on Lock Baseline. 
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Insert  baseline  

Now that Baseline has been set-up using the wizard (Part 1 of this tutorial), it  can now be inserted. This segment of the les-
son will add a baseline based on the current start and finish dates.  When the baseline is added, it will use the symbols and 
bars set up in the wizard. 

1. Chose the Insert tab. 

2. In the Baseline, Datagraph, ValueSet section choose Insert or Remove a 
Baseline. 

3. Choose Insert a Baseline. The insert baseline dialog box will appear. 

4. Choose 1 level down.   

5. Choose OK.   The schedule now has a baseline and the baseline is highlighted. 

To re-baseline your schedule 

1. Chose the Edit tab. 

2. In the Delete section choose All Baseline symbols.  The baseline will be deleted from your schedule.  

3. Reset the actual start and end date of the schedule then follow the direction under Part 2: Insert baseline to have baseline draw based 
on the reset actual start and end dates. 

By default  in the toolbox the actual and summary start symbol, horizon-
tal bar, end symbol combinations’ vertical placement is middle row  so 
are the baseline and baseline summary start symbol, horizontal bar, end 
symbol combinations.  By selecting one level down the symbols for base-
line will be placed below the actual symbols.  Symbol, horizontal bar, 
symbol combinations can be preset to a specific level  by setting the 
symbols vertical symbol position in the toolbox.  

Schedule with Inserted Baseline 
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Insert a Baseline Start Date column and a Baseline End Date column 

1. Chose the Insert tab. 

2. In the Rows, Columns section choose New Column.  

3. In the drop down dialog choose Dates.  The Insert Date Col-
umns dialog box appears.  

4. Check on Baseline Start Date.  

5. Check on Baseline End Date.  

6. Click OK.  Schedule will have the new columns. 

To change Duration settings choose 
the Layout tab.  In the Other section 
choose Duration Settings. 

Insert a Baseline Duration column 

1. Chose the Insert tab. 

2. In the Rows, Columns section choose New Column.  

3. In the drop down dialog choose Duration.  The Insert Duration 
Columns dialog box appears. 

4. Check on Baseline Duration.  

5.  Click OK.  The schedule now has a Baseline Duration column.  
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Open schedule Lesson 17 Starter Schedule Two.mlh to use to complete lesson 17 

This started schedule has the baseline symbol, horizontal bar, symbol combination and baseline start and end columns  al-
ready set-up. The horizontal bars and symbols for showing a slips have also been set-up in the toolbox. 

1. In the Files and Templates: Open and Save Options sec-
tion select Open Samples or Lessons.  The Open a Sample 
Chart dialog displays. 

2. Under Select a Folder below to Open, go to the bottom 
of the list select Lessons. The Lesson schedules will dis-
play in the window to the right. 

3. Select Lesson 17 Starter Schedule Two.mlh. 

4. Save the schedule to an accessible folder on your com-
puter. Choose the File tab.  In the Files and Templates: 
Open and Save Options section, choose Save As….  In the 
menu that displays choose Chart.  Name, then save the 
schedule. 

Add baseline to a  blank schedule 

1. Using  the (T) Text tool in the toolbox, move your cursor over to the Baseline Start cell for Phase 1, type 5/1/2019.  A red 
diamond will now display in the schedule area. 

2. Use the right keyboard arrow move to the Baseline End  cell for Phase 1, type 5/31/2020.  A red stripped horizontal bar 
with a red diamond end will attach to the existing red diamond.  

3. Move your cursor over to the Baseline Start cell for Phase 2, type 6/1/2019.  A red diamond will now display in the 
schedule area. 

4. Use the right keyboard arrow to move to the Baseline End  cell for Phase 2, type 6/30/2020.  A red stripped horizontal 
bar with a red diamond end will attach to the existing red diamond. 

7. Enter the following information for the rest of the tasks. 
Phase 3 - Baseline Start 7/1/2019  Baseline End 7/31/2020, Phase 4 - Baseline Start 8/1/2019  Baseline End 8/31/2020, 
Phase 5 - Baseline Start 10/1/2019  Baseline End 10/31/2020. After typing in Phase 5 Baseline end date do not press 
enter or the arrow key, click outside of the schedule to prevent Milestones rolling to the next page.  Should this happen 
choose the Edit tab in the Delete section choose Current page. 

Schedule with Baseline Added 

Lesson 17 Starter Schedule Two 
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Add Symbol Automation Tag columns to show baseline start and end slip dates 

When the baseline start and end dates cannot be met a slip occurs.  To show that slip date in a column you can code the 
column and a symbol to have its date populate a column. 

Insert a Date from Symbol Automation Tag column and code it to have the start slip date 

1. Click the () Arrow tool in the toolbox. 

2. Select the Baseline End column heading, it will highlight.  This will direct the inserted column to go to the left of the Base-
line End column. 

3. Choose the Insert tab. 

4. In the Rows, Column section choose New Column. 

5. From the drop down menu select Date from Symbol Automation Tag.  The Symbol Automation Tag Choice dialog dis-
plays. 

6. Under Symbol Automation Tag Text choose Date1. 

7. Under Default Symbol Type for new Symbols choose the lime dia-
mond. 

8. Choose OK then Ok again.  A column called Date1 will be added. To in-
crease the column’s width, place the cursor on the border between 
added column and baseline end column, drag the border to the right. 

9. To change the Date 1 heading, select the Date 1 column heading the 
toolbar changes to Current Object Column Heading. 

10.In Line 1, back space through Date1 then type in Start. 

11.For Line 2 type in Slip.  

Insert a Date from Symbol Automation Tag column and code it to have the start slip date 

1. Click the () Arrow tool in the toolbox. 

2. Choose the Insert tab. By default the inserted column will insert to the left of the schedule area. 

3. In the Rows, Column section choose New Column. 

4. From the menu select Date from Symbol Automation Tag.  The Symbol Automation 
Tag Choice dialog displays. 

5. Under Symbol Automation Tag Text choose Date2. 

6. Under Default Symbol Type for new Symbols choose the black diamond. 

7. Choose OK then Ok again.   

8. To change the Date 2 heading, select the Date 2 column heading the toolbar changes to Current Object Column Heading. 

9. In Line 1, back space 
through Date2 then type in 
End. 

10.For Line 2 type in Slip. 
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Add Symbol Automation Tag columns to show baseline start and end slip dates cont’d 

Code the start slip symbol in the toolbox to populate start slip column 

By coding the start slip symbol in the toolbox each 
time the symbol is added to the schedule its date will 
populate in the Start Slip column. 

1. In the toolbox, Double click the lime diamond 
(symbol on the left in the 7th row of the toolbox). 
The Symbol Options dialog displays.  

2. Select the Default Text tab. 

3. For the Default Symbol Tag type in 1,Date1. 

4. Choose OK . Nothing will change on the schedule 
until you add the start slip symbol to the schedule 
later in the tutorial. 

Code the end slip symbol in the toolbox to populate end slip column 

By coding the start slip symbol in the toolbox each 
time the symbol is added to the schedule its date will 
populate in the Start Slip column. 

1. In the toolbox, Double click the black diamond 
(symbol on the right in the 6th row of the toolbox). 
The Symbol Options dialog displays.  

2. Select the Default Text tab. 

3. For the Default Symbol Tag type in 1,Date2. 

4. Choose OK.  Nothing will change on the schedule 
until you add the end slip symbol to the schedule 
later in the tutorial. 
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Add slips  
Add the end slip symbol  

1. In the toolbox, click the (+) Plus tool. 

2. In the toolbox, click the black diamond (the right symbol in the sixth row of the toolbox). It will highlight. 

3. In the toolbox, click the black dotted horizontal bar (next to the black diamond). It will highlight. 

4. Move the cursor to the schedule area and click on the red diamond end symbol of Phase 1.  

5. Continue to hold the mouse button and drag horizontally to the right.  Let go of the mouse button on 8/31/2020. The slip 
is added and the end slip column for the task Phase 1 is populated with the slip date. 

6. Move the cursor to the schedule area and click on the red diamond end symbol of Phase 3.  

7. Continue to hold the mouse button and drag horizontally to the right.  Let go of the mouse button on 9/30/2020. The slip 
is added and the end slip column for the task Phase 3 is populated with the slip date. 

Schedule with End Slip Symbols and Populated Column 
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Add the start slip symbol  

1. In the toolbox, click the (+) Plus tool. 

2. In the toolbox, click the lime diamond (the left symbol in the seventh row of the toolbox). It will highlight. 

3. In the toolbox, click the lime dotted horizontal bar (next to the lime diamond). It will highlight. 

4. Move the cursor to the schedule area and click on the red diamond start symbol of Phase 4.  

5. Continue to hold the mouse button and drag horizontally to the left.  Let go of the mouse button on 
5/1/2019. The slip is added and the start slip column for the task Phase 4 is populated with the slip date. 

6. Move the cursor to the schedule area and click on the red diamond start symbol of Phase 5.  

7. Continue to hold the mouse button and drag horizontally to the left.  Let go of the mouse button on 8/1/2020. The slip is 
added and the end slip column for the task Phase 5 is populated with the slip date. 

Schedule with Start Slip Symbols and Populated Column 
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In this lesson you will learn how to: 

• Import Primavera information into Milestones Pro-
fessional using a XER file.   

• Update (“refresh”) the Milestones Professional 
schedule from a changed schedule. 

Import a Primavera XER File. 

1. In Milestones Professional, choose Connections tab. 

2. In the Other section choose Import Schedule from XER, XML etc. File.  
3. Select XER:Primavera XER, etc. Project Import Wizard... The Import Primavera Xer, XML, and Other File 

Types dialog displays. 

4. To select the file to import, navigate to Program 
Files\KIDASA\Milestones Professional 2021\Samples\Lessons folder.  
Select Primavera Nano.xer.  

5. Choose Continue. The first window of the Project to Milestones Wizard 
displays. 

Project to Milestones Wizard  

The Project to Milestones Wizard has four import options, three of which can be used with an XER file. Try a built-in tem-
plate (Select from predesigned templates that import specific date fields and column information from Microsoft Project 
into a Milestones schedule.) Let the wizard guide you (A wizard guides you through many choices.) Use your own custom 
template: (Pick a template you previously created and saved.)  
 
 
1. For ID Field (required), choose Text 1. 

2. Nickname (optional), this option is not 
available for XER files. 

3. For Outline level (optional), choose 20.  

4.  Import Flag (optional), this option is not 
available for XER files. 

5. Choose Try a built-in template.  

6. The Project to Milestones Wizard - Pick a built-in template dialog displays. 

Lesson 18 - Import and Refresh 
from Oracle Primavera 

Export your Primavera information into a XER file. 

Lowest level to import: The outline level 
selection can be used to limit what is im-
ported.  

Once a schedule is built it can be refreshed. 
In order for Milestones to have the connec-
tion to the tasks in Primavera it needs sym-
bols and cells to be tagged with unique 
identifiers.  Best practice is to use the    
Primavera Activity ID as the unique identifi-
er. When exported, the XER file generated 
places the Activity ID in the Text 1 field. 
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Project to Milestones Wizard - Pick a built-in template dialog  

The Built in template option has 10 categories to 
choose from.  Each Category has a variety of chart 
types.  As the category and type are selected the wizard 
displays a picture of the selection. 

Make the following selections: 

1. Choose Gantt. 

2. Choose Basic Gantt. 

3. Choose Next.  The Project to Milestones Wizard - 
Pick symbology options dialog displays. 

 

 

 

 

Project to Milestones Wizard - Pick symbology options dialog  

1. For Summary Bars choose Project.   

2. Check on Shade % complete - Symbols and horizon-
tal bars will color based on the percent complete of 
the task. 

3. Check on Show Dependencies  - Dependent symbols 
(successors) will be linked with vertical links. 

4. Choose Next.  The Project to Milestones Wizard - 
Title dialog displays. 

 

 

Project to Milestones Wizard - Add a Title dialog 

1. Select Enter a new title. 

2. In the first blank section (this will be line 1 of the 
schedule’s title), type in Project Nano. 

3. Choose Next.  

4. The Project to Milestones Wizard - Add symbol text 
and notes dialog displays. 

 

 

 

When Project is selected, summary information will be 
drawn from Primavera dates.  If Milestones is selected 
the summary bars displayed are reflections of the lower 
level tasks and can only  be changed by moving the 
lower level tasks.  

Set % for individual bars should be selected when mul-
tiple tasks are placed on a single Milestones task row.   
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The Project to Milestones Wizard - Add symbol text and notes dialog 

1. Under Start symbol text - Line 1: choose Cost from the 
drop down list.  If a Cost is associated with a task in the 
Primavera file the value will populate as symbol text for 
the finish symbol. The placement of the text to the sym-
bol is based on the symbol’s settings in the Milestones 
schedule’s toolbox.  
All other choices should say None. 

2. Choose Next.   
3. The Project to Milestones Wizard - Set schedule size 

and rows dialog displays. 
 
 
 
The Project to Milestones Wizard - Set schedule size and rows dialog  

1. For Rows per page choose 18. 

2. Check on Show the Legend. 

3. Choose Next.  

4. The Project to Milestones Wizard -  Apply a color 
theme dialog displays. 

 

 

 

 

 

 

 

The Project to Milestones Wizard - Apply a color theme dialog 

1. Under Apply a color theme choose Autumn. 

2. Choose Use Outline Shading. 

3. Check on Include toolbox colors. 

4. Choose Finish. 

Milestones will now generate the schedule found on the 
following page.  
 

Symbol notes can be hidden or shown. Check on Show 
notes on schedule to have the note display near the start 
symbol.  (Once the schedule is imported, the note can be 
dragged anywhere on the schedule and is still attached to 
its symbol.) 
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.  Leave it open for the next section of 

Schedule from Imported XER File. 

Customize the imported schedule 

Change the Bar Color 

1.  Double click the second horizontal bar in the toolbox.  The 
Bar options dialog displays. 

2. Change the Fill Color to orange. 

3. Choose OK. 

4. All bars on the schedule using the second horizontal bar in 
the toolbox are now orange. 
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Customize the imported schedule (continued) 

Change the Title 

1. Click the title.  The toolbar at the top of 
the Milestones window is now active 
for the title.  

2. Change the text color in Line 1 to black. 

3. Uncheck Insert extra space under title. 

 

 

 

 

Change the Symbol Size 

1. Choose the Format tab. 

2. In the Frame, Highlights section select Symbol 
Size. 

3. In the drop down that displays select 1.0. 

4. Below is the customized schedule. Keep the 
Milestones file open to continue with the next 
portion of this tutorial. 

Customized Milestones Professional Schedule with the change s to horizontal bars, title and symbols size. 
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Save as a Custom Project Template. 

Now that you have your schedule looking exactly how you want, it can be saved as a Custom Project Template.  Saving the 
schedule as Custom Project Template adds the schedule into the Project to Milestones Wizard.  Once saved, next time you 
use the Project to Milestones Wizard it will be available in the Use your own custom template option for import of another 
Microsoft Project file. 

1. Choose the Connections tab.  

2. In the Microsoft Project section choose Save Custom Project Template. 

3. The Microsoft Project Custom Import Template Description dialog box displays. Enter a description for your template 
like “My template with start, end, baseline start end bars.” 

4. Choose OK. 

5. The Save Chart File dialog box displays.  

6. Give your template a name like: CustomTemplateProjectNano. 

7. Choose Save. 

8. Close the schedule. 

 

Import Primavera XER Files using the Use Your Own Custom Template Option 

Now you will import the Nano XER into the Custom Project Template, CustomTemplateProjectNano, you just created. 

1. In Milestones Professional, choose the Connections tab. 

2. In the Other section choose Import Schedule from XER, XML etc. File.  

3. Select XER:Primavera XER, etc. Project Import Wizard... The Import Primavera Xer, XML, and Other File Types dialog 
displays. 

4. To select the file to import, navigate to Program Files\KIDASA\Milestones Professional 2019\Samples\Lessons folder.  
Select Primavera Nano.xer.  

5. Choose Continue. The first window of the Project to Milestones Wizard displays. 

Project to Milestones Wizard 

1. For ID Field (required) , choose Text 1  

2. Leave Nickname (optional) blank 

3. For Outline level (optional) choose 20.   

4.  Import Flag (optional) This option is not a choice avail-
able for XER files. 

5. Choose Use your own custom template.  

6. The Project to Milestones Wizard - Custom template 
options dialog displays. 

 

 

 

 

 

Important:  
Save all Custom Project Templates to a folder that you will not delete or move.  This should not be the same folder where you save 
your working Milestones Professional files. 
 
If an initial import file has more than one page and you want to use it as a Custom Project Template, delete all but one page of the 
schedule before saving it as a Custom Project Template. 
 
If you save a Custom Project Template and no longer want to see it in the wizard Use the Manage Custom Project Templates option 
found on the Connections tab in the Microsoft Project section. 
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The Project to Milestones Wizard - Custom template options dialog 

1. At the top of the dialog click the down arrow to select 
the saved custom template, CustomTemplateProject-
Nano.mlj. Note that the Wizard displays a picture of the 
CustomTemplateProjectNano.mlj. 

2. Under Start Symbol Text, next to 1: Click the down ar-
row and then select Percent Complete.  

3. Choose Project summary bars. 

4. Check on Color Critical Tasks Red. 

5. Choose Finish. The generated file (see below) will look 
like the saved Custom Project Template, CustomTemplateProjectNano.mlj, with the exception of the new options select-
ed; critical task colored red. 

6. Save this file to a different location than were you saved the Custom Project Template.  Choose Save As. Choose Chart.  
Call the schedule Project Nano.  You will use this schedule later in the tutorial, so keep it opened. 

Even if your template has symbol and note text from the 
initial import, you still must select the symbol or note text in 
this dialog to have text display on the generated schedule. 

Select this option to have all Primavera tasks marked as 
critical color red in the generated Milestone file. 

Generated Milestones Professional Schedule 
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Update (“refresh”) the Milestones Professional schedule from a changed XER file 
The Changed Primavera  Nano.xer that will be used in this section was generated after the following change was made to 
the initially imported Primavera  Nano.xer  

Development Stage sub task Design New Product finish date changed from 5/31/2011 to 6/30/2011.  Due to this change 
the following item also changed. 

• Development Stage sub task Design New Product % Complete changed from 46% to 30%. 

 

Refresh the Milestones Professional schedule to reflect the changes made to the Primavera  Nano.xer file 

1. Go back to Milestones Professional.  The Project Nano.mlj schedule should still be opened. If not open it. 

2. Choose the Connections tab. 

3. In the Microsoft Project section choose Refresh Previously imported 
Project. 

4. From the drop down choose Refresh from Primavera XER File…   

5. The  Select the file to refresh dialog box displays. Select Changed Primavera  Nano.xer by 
navigating to the Program Files\KIDASA\Milestones Professional 2021\Samples\Lessons 
folder. Choose Open.  

6. The MS Project format XML Refresh Options dialog displays. 

 

 

The MS Project format XML Refresh Options dialog 

1. Choose the Connections tab. 

2. Under Symbol Text check on Refresh Symbol 
Text. 

3. Under Symbol Text choose: Update only sym-
bols with symbol text tags.  This is necessary as 
some percent complete values in the primavera 
XER file changed, so the percent complete val-
ues as symbol text on the Milestones schedule 
need to be updated. 

4. Under Percent Complete: Check on Refresh 
percent complete.  

5. Under Percent Complete for the % complete 
field choose % Complete. This is necessary to 
have the fill to status of the symbols and hori-
zontal bars update. 

6. Under Options check on Refresh tagged col-
umns. To have the information in the Percent 
Complete column update based on the changes 
in the Microsoft Project file. 

7. Under Options check on Ignore times. Only the 
date of a task will be considered when the file is 
updated. 

8. Under Options check on Highlight Changed 
Dates.  To have any Baseline and Normal sym-
bols that update highlight in orange. 

9. Check on  Ignore Status Symbols and Ignore Comment Symbols  

10.Choose Refresh. The schedule will be generated 

See the next page to view the updated Milestones schedule.  It reflects the change made to the finish date which impacted 
percent complete, the percent complete column, and the percent complete value as symbol text. 
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As selected in the Refresh dialog box, highlighted in orange is the finish date that changed in the Primavera file.  
Note: The percent value as symbol text updated and the Percent Complete column value has changed, these we have high-
lighted with a green box.   

To turn off orange highlighting choose the Connections tab in the Other section uncheck Refresh Highlighting. 

Highlighting does not save when the file is saved. 

Refreshed Milestones Professional Schedule 
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Lesson 19 - Microsoft Project to Milestones 
Wizard - Microsoft Project Not installed 

In this lesson you will learn how to: 

• Import Microsoft Project MPP files into Milestones 
Professional using the import wizard. 

• Customize the imported schedule. 

• Save as a Custom Project Template. 

• Import Microsoft Project MPP files using the new Cus-
tom Project Template. 

• Use a changed Microsoft Project MPP file to update 
(“refresh”) the Milestones Professional schedule. 

Import a Microsoft Project MPP  

1. In Milestones Professional, choose the Connections tab. 

2. In the Microsoft Project section choose Create Report from Project. The Import a 
Microsoft Project MPP file dialog box displays. 

3. Choose the browse button and navigate to the Program Files\KIDASA\Milestones 
Professional 2021\Samples\Lesson folder. Select MS Project File.mpp.  

4. Choose Continue.   

5. The Microsoft Project to Milestones Wizard will display. 

 

Microsoft Project to Milestones Wizard  

The Microsoft Project to Milestones Wizard has four import options. Try a built-in template: Select from predesigned templates 
that import specific date fields and column information from Microsoft Project into a Milestones schedule. Let the wizard guide 
you: Step by step selection of how you want your Microsoft Project information imported into a Milestones schedule. Make a 
swimlane chart: Only works if Microsoft Project is installed on your computer.  Use your own custom template: Starting with a 
schedule imported using the wizard then modified to your liking then saved to use the next time you import. 
 
1. For ID Field (required) , choose Uniqueid. 

2. Nickname (optional), this option is only available if Microsoft 
Project is installed. 

3. For Outline level ( optional ), choose 20.  

4. Import Flag (optional), choose All Tasks. 

5. Choose Try a built-in template.  

6. The Project to Milestones Wizard - Pick a built-in template dia-
log displays. 

Important This lesson is only for importing an MPP file when Microsoft Project is NOT installed on your computer. If you have Microsoft 
Project, go to lesson 16.   

Once a schedule is built it can be refreshed. In order for Milestones to 
have the connection to the tasks in Microsoft Project it needs symbols 
and cells to be tagged with unique identifiers.  Best practice is to use 
the Microsoft Project Unique ID field for the unique identifier.   

For More information choose the         question mark Icon.  
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Project to Milestones Wizard - Pick a built-in template dialog  

The Built in template option has 10 categories to choose from 
and each Category has a variety of chart types.  As the catego-
ry and type are selected the wizard displays a picture of the 
selection. 

Make the following selections: 

1. Choose Gantt. 

2. Choose Basic Gantt. 

3. Choose Next.  The Project to Milestones Wizard - Pick sym-
bology options dialog displays. 

 

 

 

 

Project to Milestones Wizard - Pick symbology options dialog  

1. For Summary Bars choose Project.   

2. Check on Shade % complete - Symbols and horizontal bars 
color based on the percent complete of the task. 

3. Check on Show Dependencies  - Dependent symbols ( suc-
cessors) will be linked with vertical links. 

4. Choose Next.   

5. The Project to Milestones Wizard - Add a title dialog displays. 

 

Project to Milestones Wizard -  Add a Title dialog 

1. Select Enter a new title. 

2. In the first blank section (this will be line 1 of the schedule’s 
title), type in Alpha & Beta Projects. 

3. In the second blank section, (this will be line 2 of the sched-
ule’s title), type in Review Schedule. 

4. Choose Next.  

5. The Project to Milestones Wizard - Add symbol text and 
notes dialog displays. 

 

 

 

Summary information will be drawn from Microsoft Project 
information and symbols and bars are independent of lower 
level information.  If Milestones is selected the summary bars 
displayed are reflections of the lower level tasks and can only  
be changed by moving the lower level tasks.  

Set % for individual bars should be selected when multiple 
tasks are placed on a single Milestones task row.   
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The Project to Milestones Wizard - Add symbol text and notes dialog 

1. Under Finish symbol text - Line 1: choose Resource Names 
from the drop down list. The task’s resource names will 
populate as symbol text for the finish symbol. The place-
ment of the text to the symbol is based on the symbol’s 
settings in the Milestones schedule’s toolbox. 

2. Under Start symbol note choose Percent Complete from 
the drop down list . The % complete for the Microsoft Pro-
ject  task will populate as a symbol note for the start sym-
bol.  

3. Check on Show notes on schedule, to have the note display 
near the start symbol.  Once the schedule is imported, the 
note can be dragged anywhere on the schedule and is still 
attached to its symbol. 

4. Choose Next.  The Project to Milestones Wizard - Layout 
options dialog displays. 

 
 

 

 

The Project to Milestones Wizard - Set schedule size and 
rows dialog  

1. For Rows per page choose 8. 

2. Check on Show the Legend. 

3. Choose Next. The Project to Milestones Wizard -  Apply a 
color theme dialog displays. 

 

 

 

 

 

 

 

 

 

The Project to Milestones Wizard - Apply a color theme dia-
log 
1. Under Apply a color theme choose Autumn. 

2. Choose Use Outline Shading. 

3. Check on Include toolbox colors. 

4. Choose Finish. 

Milestones will now generate the schedule found on the fol-
lowing page.  
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Customize the imported schedule 

Change the Bar Color 

1. Double click the second horizontal bar in the toolbox.  The Bar 
options dialog displays. 

2. Change the Fill Color to orange. 

3. Choose OK. 

4. All bars on the schedule using the second horizontal bar in the 
toolbox are now orange. 

 

Generated Milestones Professional Schedule 
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Customize the imported schedule (continued) 

Change the Title 

1. Click the title.  The toolbar at the top of the Mile-
stones window is now active for the title.  

2. Change the text color in Line 1 and Line 2 to black. 

3. Uncheck Insert extra space under title. 

 

 

 

 

Change the Symbol Size 

1. Choose the Format tab. 

2. In the Frame, Highlights section select Symbol Size. 

3. In the drop down that displays select 1.0. 

4. Below is the Customized schedule. 

5. Keep the Milestones file open to continue with the next 
portion of this tutorial. 

Customized Milestones Professional Schedule with the change s to horizontal bars, title and symbols size. 
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Save as a Custom Project Template. 

Now that you have your schedule looking exactly how you want, it can be saved as a Custom Project Template.  Saving the sched-
ule as Custom Project Template adds the schedule into the Project to Milestones Wizard.  Once saved, next time you use the Pro-
ject to Milestones Wizard it will be available in the Use your own custom template option for import of another Microsoft Project 
file. 

1. Choose the Connections tab.  

2. In the Microsoft Project section choose Save Custom Project Template. 

3. The Microsoft Project Custom Import Template Description dialog box displays. Enter a description for your template like “My 
template with start, end, baseline start end bars.” 

4. Choose OK. 

5. The Save Chart File dialog box displays.  

6. Give your template a name CustomTemplateAlpha&Beta. 

7. Choose Save. 

8. Close the schedule. 

 

Import Microsoft Project MPP files using the new Custom Project Template 

Now you will import the MS Project file.mpp into the Custom Project Template, CustomTemplateAlpha&Beta you just created. 

1. In Milestones Professional, choose the Connections tab. 

2. In the Microsoft Office Project section choose Create Report from Project. The Import a Microsoft Project MPP file dialog box 

displays. 

3. Choose the browse button and navigate to the Program Files\KIDASA\Milestones Professional 2021\Samples\Lesson folder. 

4. Select the MS Project File.mpp file.  The Project to Milestones Wizard will display. 

Project to Milestones Wizard 

1. For ID Field (required) , choose Uniqueid. 

2. Leave Nickname (optional) blank. 

3. For Outline level ( optional ) choose 20. For Tag . 

4. Import Flag (optional) choose All Tasks. 

5. Choose Use your own custom template. The Project to 

Milestones Wizard - Custom template options dialog 

displays. 

 

 

 

 

 

 

 

Important:  
Save all Custom Project Templates to a folder that you will not delete or move.  This should not be the same folder where you save your 
working Milestones Professional files. 
 
If an initial import file has more than one page and you want to use it as a Custom Project Template delete all but one page of the schedule 
before saving it as a Custom Project Templates . 
 
If you save a Custom Project Template and no longer want to see it in the wizard Use the Manage Custom Project Templates option found 
on the Connections tab in the Microsoft Project section. 
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The Project to Milestones Wizard - Custom template options dialog 

1. At the top of the dialog click the down arrow to select 
the saved custom template, CustomTemplateAl-
pha&Beta.mlj. Note that the Wizard displays a picture of 
the CustomTemplateAlpha&Beta.mlj. 

2. Under Start Symbol Text, next to 1: Click the down ar-
row and then select Percent Complete.  

3. Choose Project summary bars. 

4. Check on Color Critical Tasks Red. 

5. Choose Finish. The generated file (see below) will look 
like the saved Custom Project Template, CustomTem-
plateAlpha&Beta.mlj, with the exception of the new options selected; critical task colored red. 

6. Save this file to a different location than where you saved the Custom Project Template.  Choose Save As. Choose Chart.  Call the 
schedule Alpha & Beta Projects.  You will use this schedule later in the tutorial, so keep it opened. 

Even if your template has symbol and note text from the 
initial import, you still must select the symbol or note text in 
this dialog to have text display on the generated schedule. 

Select this option to have all Microsoft Project tasks marked 
as critical color red in the generated Milestone file. 

Generated Milestones Professional Schedule 
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Refresh an imported Milestones Professional schedule when the Microsoft Project file has been changed  

The changed Microsoft Project file 

The following changes were made to the MS Project File.mpp and renamed MS Project File Changed.mpp 
Project Beta tasks: 

a. Design Finish Date changed from 6/02/22 to 7/02/22. Because of this change the following other items changed 

• Design % Complete changed from 50% to 36%. 

b. Test Finish Date changed from 8/05/22 to 9/05/22. Because of this change the following other items changed 

• Design % Complete changed from 35% to 22%. 

Because of the above a and b changes the following items in Project Beta summary changed  

• Project Beta  % Complete changed from 37% to 28%. 

• The Overall Project Task  % Complete changed from 37% to 32%. 

Refresh the Milestones Professional schedule to reflect the changes made to the Microsoft Project file  

1. Go back to Milestones Professional, Alpha & Beta Projects.mlj schedule.  It should still be opened. If not open it. 

2. Choose the Connections tab. 

3. In the Microsoft Project section choose Refresh Previously imported Pro-
ject. 

4. From the drop down choose Refresh from MPP/MPD File…  The Select the 
file to refresh dialog box displays. 

5. Select MS Project File Changed.mpp by navigating to the Program Files\KIDASA\Milestones Profes-
sional 2021\Samples\Lessons folder. Choose Open.  

6. The MS Project format XML Refresh Options dialog displays. 

 

The MS Project format XML Refresh Options  

1. For Refresh Using : select UniqueID. You should always select the 
unique identifier used in the original import. 

2. Under Symbol Text check on Refresh Symbol Text. 

3. Under Symbol Text choose: Update only symbols with symbol text 
tags.  This is necessary as some percent complete values in the 
Microsoft Project file changed, thus the percent complete values as 
symbol text on the Milestones schedule need to be updated. 

4. Under Percent Complete: Check on Refresh percent complete.  

5. Under Percent Complete for the % complete field choose % Com-
plete. This is necessary to have the fill to status of the symbols and 
horizontal bars update. 

6. Under Options check on Refresh tagged columns. To have the in-
formation in the Percent Complete column update based on the 
changes in the Microsoft Project file. 

7. Under Options check on Ignore times. Only the date of a task will 
be considered when the file is updated. 

8. Under Options check on Highlight Changed Dates.  To have any 
Baseline and Normal symbols that update highlight in orange. 

9. Uncheck to Ignore Status Symbols. To have any status symbols (control percent complete) highlight in orange when the percent 
complete of a task changes. 

10.Choose Refresh. The schedule will be generated. 

See the next page to view the Refreshed Milestones schedule reflecting the changes made to the finish dates which impacted per-
cent complete thus status symbols,  the percent complete column, and the percent complete value as symbol text. 
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As selected in the Refresh dialog box, highlighted in orange are the finish dates that were changed in the Microsoft Project file. Be-
cause the finish dates were changed the percent complete also changed thus forcing the status symbols to move and they are also 
highlighted in orange.  
Note: The percent values as symbol text updated and some Percent Complete column values have changed, these we have high-
lighted with a green box.   

To turn off orange highlighting choose the Connections tab in the Other section uncheck Refresh Highlighting. 

Highlighting does not save when the file is saved. 

Refreshed Milestones Professional Schedule 
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